Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
Presence/Absence Experiments
Applied Biosystems StepOne™ and StepOnePlus™
Real-Time PCR Systems
Presence/Absence Experiments

1. Get Started

2. Design the Experiment

3. Prepare the Reactions

4. Run the Experiment

5. Analyze the Experiment
# Contents

<table>
<thead>
<tr>
<th>Preface</th>
<th>vii</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to Use This Guide</td>
<td>vii</td>
</tr>
<tr>
<td>How to Obtain More Information</td>
<td>ix</td>
</tr>
<tr>
<td>How to Obtain Support</td>
<td>xii</td>
</tr>
<tr>
<td>Safety Conventions Used in This Document</td>
<td>xiii</td>
</tr>
<tr>
<td>Symbols on Instruments</td>
<td>xiv</td>
</tr>
<tr>
<td>Safety Labels on Instruments</td>
<td>xvi</td>
</tr>
<tr>
<td>General Instrument Safety</td>
<td>xvii</td>
</tr>
<tr>
<td>Chemical Safety</td>
<td>xviii</td>
</tr>
<tr>
<td>Chemical Waste Safety</td>
<td>xix</td>
</tr>
<tr>
<td>Electrical Safety</td>
<td>xx</td>
</tr>
<tr>
<td>LED Safety</td>
<td>xxi</td>
</tr>
<tr>
<td>Biological Hazard Safety</td>
<td>xxii</td>
</tr>
<tr>
<td>Workstation Safety</td>
<td>xxii</td>
</tr>
<tr>
<td>Safety and Electromagnetic Compatibility (EMC) Standards</td>
<td>xxii</td>
</tr>
</tbody>
</table>

## Chapter 1

### Get Started

- **About the StepOne™ and StepOnePlus™ Systems**  
- **Supported Consumables**  
- **About Presence/Absence Experiments**  
- **How to Use This Guide**  
- **About the Example Experiment**  
- **Example Experiment Workflow**

## Chapter 2

### Design the Experiment

- **Chapter Overview**  
- **Create a New Experiment**  
- **Define the Experiment Properties**  
- **Define the Methods and Materials**  
- **Set Up the Targets**  
- **Set Up the Samples and Replicates**  
- **Set Up the Run Method**  
- **Review the Reaction Setup**  
- **Order Materials for the Experiment**  
- **Finish the Design Wizard**
# Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Presence/Absence Experiments

## Chapter 3 Prepare the Reactions

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter Overview</td>
<td>42</td>
</tr>
<tr>
<td>Prepare the Template</td>
<td>43</td>
</tr>
<tr>
<td>Prepare the Samples</td>
<td>44</td>
</tr>
<tr>
<td>Prepare the Reaction Mix</td>
<td>46</td>
</tr>
<tr>
<td>Prepare the Reactions</td>
<td>48</td>
</tr>
</tbody>
</table>

## Chapter 4 Run the Experiment

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter Overview</td>
<td>54</td>
</tr>
<tr>
<td>Prepare for the Run</td>
<td>55</td>
</tr>
<tr>
<td>(Optional) Enable the Notification Settings</td>
<td>57</td>
</tr>
<tr>
<td>Start the Run</td>
<td>59</td>
</tr>
<tr>
<td>Monitor the Run</td>
<td>63</td>
</tr>
<tr>
<td>Unload the Instrument and Transfer the Data</td>
<td>70</td>
</tr>
</tbody>
</table>

## Chapter 5 Analyze the Experiment

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter Overview</td>
<td>76</td>
</tr>
<tr>
<td>Section 5.1: Review Results</td>
<td>77</td>
</tr>
<tr>
<td>Analyze the Experiment</td>
<td>78</td>
</tr>
<tr>
<td>View the Presence/Absence Plot</td>
<td>84</td>
</tr>
<tr>
<td>View the Amplification Plot</td>
<td>86</td>
</tr>
<tr>
<td>View the Well Table</td>
<td>93</td>
</tr>
<tr>
<td>Publish the Data</td>
<td>96</td>
</tr>
<tr>
<td>Section 5.2: Troubleshoot (If Needed)</td>
<td>97</td>
</tr>
<tr>
<td>View the Analysis Settings</td>
<td>98</td>
</tr>
<tr>
<td>View the QC Summary</td>
<td>100</td>
</tr>
<tr>
<td>Omit Wells from the Analysis</td>
<td>102</td>
</tr>
<tr>
<td>View the Multicomponent Plot</td>
<td>103</td>
</tr>
<tr>
<td>View the Raw Data Plot</td>
<td>105</td>
</tr>
</tbody>
</table>

## Appendix A Alternate Experiment Workflows

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Setup Workflow</td>
<td>110</td>
</tr>
<tr>
<td>QuickStart Workflow</td>
<td>111</td>
</tr>
<tr>
<td>Template Workflow</td>
<td>113</td>
</tr>
<tr>
<td>Export/Import Workflow</td>
<td>115</td>
</tr>
</tbody>
</table>

## Bibliography

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>119</td>
</tr>
</tbody>
</table>
### Preface

#### How to Use This Guide

**About the System Documentation**

The guides listed below are shipped with the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems (StepOne™ and StepOnePlus™ systems).

<table>
<thead>
<tr>
<th>Guide</th>
<th>Purpose and Audience</th>
<th>PN</th>
</tr>
</thead>
</table>
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Genotyping Experiments** | Explains how to perform experiments on the StepOne and StepOnePlus systems. Each Getting Started Guide functions as both:  
- A tutorial, using example experiment data provided with the Applied Biosystems StepOne™ Real-Time PCR Software (StepOne™ software).  
- A guide for your own experiments.  
Intended for laboratory staff and principal investigators who perform experiments using the StepOne or StepOnePlus system. | 4376786 |
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Presence/Absence Experiments** |  | 4376787 |
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative Standard Curve and Comparative C_T Experiments** |  | 4376785 |
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard Curve Experiments** |  | 4376784 |
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide** | Explains how to install and maintain the StepOne and StepOnePlus systems.  
Intended for laboratory staff responsible for the installation and maintenance of the StepOne or StepOnePlus system | 4376782 |
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation Quick Reference Card** |  | 4376783 |
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide** | Provides information about the reagents you can use on the StepOne and StepOnePlus systems, including:  
- An introduction to TaqMan® and SYBR® Green reagents  
- Descriptions and design guidelines for the following experiment types:  
  - Quantitation experiments  
  - Genotyping experiments  
  - Presence/absence experiments  
Intended for laboratory staff and principal investigators who perform experiments using the StepOne or StepOnePlus system. | 4379704 |
Preface
How to Use This Guide

Assumptions
This guide assumes that you:

- Are familiar with the Microsoft Windows® XP operating system.
- Are familiar with the Internet and Internet browsers.
- Know how to handle DNA and/or RNA samples and prepare them for PCR.
- Understand data storage, file transfer, and copying and pasting.
- Have networking experience, if you plan to integrate the StepOne or StepOnePlus system into your existing laboratory data flow.

Text Conventions
This guide uses the following conventions:

- **Bold** text indicates user action. For example:
  Type 0, then press **Enter** for each of the remaining fields.
- *Italic* text indicates new or important words and is also used for emphasis.
  For example:
  Before analyzing, *always* prepare fresh matrix.
- A right arrow symbol (→) separates successive commands you select from a drop-down or shortcut menu. For example:
  Select **File** → **Open**.

User Attention Words
Two user attention words appear in Applied Biosystems user documentation. Each word implies a particular level of observation or action as described below:

**Note:** – Provides information that may be of interest or help but is not critical to the use of the product.

**IMPORTANT!** – Provides information that is necessary for proper instrument operation, accurate reagent kit use, or safe use of a chemical.
Examples of the user attention words appear below:

**Note:** The Calibrate function is also available in the Control Console.

**IMPORTANT!** To verify your client connection, you need a valid user ID.

**Safety Alert Words**

Safety alert words also appear in user documentation. For more information, see “Safety Alert Words” on page xiii.

### How to Obtain More Information

#### Related Documentation

**Other StepOne and StepOnePlus System Documents**

The documents listed in the table below are not shipped with the StepOne or StepOnePlus instrument.

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</em></td>
<td>4376791</td>
</tr>
<tr>
<td>Installation Performance Verification Protocol</td>
<td></td>
</tr>
<tr>
<td><em>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</em></td>
<td>4376790</td>
</tr>
<tr>
<td>Installation Qualification-Operation Qualification Protocol</td>
<td></td>
</tr>
<tr>
<td><em>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</em></td>
<td>4376788</td>
</tr>
<tr>
<td>Planned Maintenance Protocol</td>
<td></td>
</tr>
</tbody>
</table>

**Documents Related to Genotyping Experiments**

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Discrimination Pre-Developed TaqMan® Assay Reagents Quick Reference Card</td>
<td>4312212</td>
</tr>
<tr>
<td>Custom TaqMan® Genomic Assays Protocol</td>
<td>4367671</td>
</tr>
<tr>
<td>Custom TaqMan® SNP Genotyping Assays Protocol</td>
<td>4334431</td>
</tr>
<tr>
<td>Ordering TaqMan® SNP Genotyping Assays Quick Reference Card</td>
<td>4374204</td>
</tr>
<tr>
<td>Performing a Custom TaqMan® SNP Genotyping Assay for 96-Well Plates Quick Reference Card</td>
<td>4371394</td>
</tr>
<tr>
<td>Performing a TaqMan® Drug Metabolism Genotyping Assay for 96-Well Plates Quick Reference Card</td>
<td>4367636</td>
</tr>
<tr>
<td>Pre-Developed TaqMan® Assay Reagents Allelic Discrimination Protocol</td>
<td>4312214</td>
</tr>
<tr>
<td>TaqMan® Drug Metabolism Genotyping Assays Protocol</td>
<td>4362038</td>
</tr>
<tr>
<td>TaqMan® SNP Genotyping Assays Protocol</td>
<td>4332856</td>
</tr>
</tbody>
</table>
**Documents Related to Presence/Absence Experiments**

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs Protocol</td>
<td>4343586</td>
</tr>
<tr>
<td>NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue Protocol</td>
<td>4333959</td>
</tr>
<tr>
<td>PrepMan® Ultra Sample Preparation Reagent Protocol</td>
<td>4318925</td>
</tr>
</tbody>
</table>

**Documents Related to Relative Standard Curve and Comparative C<sub>T</sub> Experiments**

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</td>
<td>127AP05</td>
</tr>
<tr>
<td>Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol</td>
<td>4375575</td>
</tr>
<tr>
<td>Custom TaqMan® Gene Expression Assays Protocol</td>
<td>4334429</td>
</tr>
<tr>
<td>Primer Express® Software Version 3.0 Getting Started Guide</td>
<td>4362460</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Assays Protocol</td>
<td>4333458</td>
</tr>
<tr>
<td>User Bulletin #2: Relative Quantitation of Gene Expression</td>
<td>4303859</td>
</tr>
</tbody>
</table>

**Documents Related to Standard Curve Experiments**

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</td>
<td>127AP05</td>
</tr>
<tr>
<td>Custom TaqMan® Gene Expression Assays Protocol</td>
<td>4334429</td>
</tr>
<tr>
<td>Primer Express® Software Version 3.0 Getting Started Guide</td>
<td>4362460</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Assays Protocol</td>
<td>4333458</td>
</tr>
<tr>
<td>User Bulletin #2: Relative Quantitation of Gene Expression</td>
<td>4303859</td>
</tr>
</tbody>
</table>
Documents Related to the Reagent Guide

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol</td>
<td>4375575</td>
</tr>
<tr>
<td>Custom TaqMan® Gene Expression Assays Protocol</td>
<td>4334429</td>
</tr>
<tr>
<td>Custom TaqMan® Genomic Assays Protocol: Submission Guidelines</td>
<td>4367671</td>
</tr>
<tr>
<td>Custom TaqMan® SNP Genotyping Assays Protocol</td>
<td>4334431</td>
</tr>
<tr>
<td>Power SYBR® Green PCR Master Mix and RT-PCR Protocol</td>
<td>4367218</td>
</tr>
<tr>
<td>Pre-Developed TaqMan® Assay Reagents Allelic Discrimination Protocol</td>
<td>4312214</td>
</tr>
<tr>
<td>Primer Express® Software Version 3.0 Getting Started Guide</td>
<td>4362460</td>
</tr>
<tr>
<td>SYBR® Green PCR and RT-PCR Reagents Protocol</td>
<td>4304965</td>
</tr>
<tr>
<td>SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol</td>
<td>4310251</td>
</tr>
<tr>
<td>TaqMan® Drug Metabolism Genotyping Assays Protocol</td>
<td>4362038</td>
</tr>
<tr>
<td>TaqMan® Exogenous Internal Positive Control Reagents Protocol</td>
<td>4308335</td>
</tr>
<tr>
<td>TaqMan® Fast Universal PCR Master Mix (2X) Protocol</td>
<td>4351891</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Assays Protocol</td>
<td>4333458</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Master Mix Protocol</td>
<td>4371135</td>
</tr>
<tr>
<td>TaqMan® Genotyping Master Mix Protocol</td>
<td>4371131</td>
</tr>
<tr>
<td>TaqMan® SNP Genotyping Assays Protocol</td>
<td>4332856</td>
</tr>
<tr>
<td>TaqMan® Universal PCR Master Mix Protocol</td>
<td>4304449</td>
</tr>
<tr>
<td>User Bulletin #2: Relative Quantitation of Gene Expression</td>
<td>4303859</td>
</tr>
<tr>
<td>Using TaqMan® Endogenous Control Assays to Select an Endogenous Control for Experimental Studies Application Note</td>
<td>127AP08</td>
</tr>
</tbody>
</table>

Note: For more documentation, see “How to Obtain Support” on page xii.

Obtaining Information from the Software Help

The StepOne Software Help describes how to use each feature of the user interface. Access the Help from within the software by doing one of the following:

- Press **F1**.
- Click 📖 in the toolbar.
- Select **Help ➤ StepOne Software Help**.

To find topics of interest in the Help:

- Review the table of contents.
- Search for a specific topic.
- Search an alphabetized index.
Send Us Your Comments
Applied Biosystems welcomes your comments and suggestions for improving its user documents. You can e-mail your comments to:

technubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and suggestions relating to documentation. To order documents, download PDF files, or for help with a technical question, go to http://www.appliedbiosystems.com, then click the link for Support. (See “How to Obtain Support” on page xii).

How to Obtain Support

For the latest services and support information for all locations, go to http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:
- Search through frequently asked questions (FAQs)
- Submit a question directly to Technical Support
- Order Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents
- Download PDF documents
- Obtain information about customer training
- Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities.

IMPORTANT! When directed to do so by this guide, or when you need to schedule maintenance for your StepOne™ or StepOnePlus™ instrument (such as annual planned maintenance or temperature verification/calibration), contact the Applied Biosystems Care Center. To obtain a phone number for or to send an email to the center, go to http://www.appliedbiosystems.com/support/contact.
Safety Conventions Used in This Document

Safety Alert Words

Four safety alert words appear in Applied Biosystems user documentation at points in the document where you need to be aware of relevant hazards. Each alert word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of observation or action, as defined below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation, accurate reagent kit use, or safe use of a chemical.

⚠ CAUTION — Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

⚠ WARNING — Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

⚠ DANGER — Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. This signal word is limited to the most extreme situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document appears with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard symbols that are affixed to Applied Biosystems instruments (see “Safety Symbols” on page xv).
Examples

**IMPORTANT!** You must create a separate sample entry spreadsheet for each 96-well plate.

**CAUTION** CHEMICAL HAZARD. TaqMan® Universal PCR Master Mix may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

**WARNING** PHYSICAL INJURY HAZARD. During instrument operation, the heated cover and sample block can reach temperatures in excess of 100 °C.

**DANGER** ELECTRICAL HAZARD. Grounding circuit continuity is vital for the safe operation. Never operate the system with the grounding conductor disconnected.

Symbols on Instruments

**Electrical Symbols**

The following table describes the electrical symbols that may be displayed on Applied Biosystems instruments.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="On" /></td>
<td>Indicates the <strong>On</strong> position of the main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Off" /></td>
<td>Indicates the <strong>Off</strong> position of the main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Standby" /></td>
<td>Indicates a standby switch by which the instrument is switched on to the <strong>Standby</strong> condition. Hazardous voltage may be present if this switch is on standby.</td>
</tr>
<tr>
<td><img src="image" alt="On/Off" /></td>
<td>Indicates the <strong>On/Off</strong> position of a push-push main power switch.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Signal Ground" /></td>
<td>Indicates a terminal that may be connected to the signal ground reference of another instrument. This is not a protected ground terminal.</td>
</tr>
<tr>
<td><img src="image" alt="Protective Ground" /></td>
<td>Indicates a protective grounding terminal that must be connected to earth ground before any other electrical connections are made to the instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Alternating Current" /></td>
<td>Indicates a terminal that can receive or supply alternating current or voltage.</td>
</tr>
<tr>
<td><img src="image" alt="Direct Current" /></td>
<td>Indicates a terminal that can receive or supply alternating or direct current or voltage.</td>
</tr>
</tbody>
</table>
### Safety Symbols

The following table describes the safety symbols that may be displayed on Applied Biosystems instruments. Each symbol may appear by itself or with text that explains the relevant hazard (see “Safety Labels on Instruments” on page xvi). These safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that occur in the text of this and other product-support documents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Indicates that you should consult the manual for further information and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Indicates the presence of moving parts and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>🔥</td>
<td>Indicates the presence of an electrical shock hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>🌡️</td>
<td>Indicates the presence of a hot surface or other high-temperature hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>☀️</td>
<td>Indicates the presence of a laser inside the instrument and to proceed with appropriate caution.</td>
</tr>
</tbody>
</table>

### Environmental Symbols

The following symbol applies to all Applied Biosystems electrical and electronic products placed on the European market after August 13, 2005.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🇪🇺</td>
<td>Do not dispose of this product as unsorted municipal waste. Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of waste electrical and electronic equipment (WEEE). European Union customers: Call your local Applied Biosystems Customer Service office for equipment pick-up and recycling. See <a href="http://www.appliedbiosystems.com">http://www.appliedbiosystems.com</a> for a list of customer service offices in the European Union.</td>
</tr>
</tbody>
</table>
Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on Applied Biosystems instruments in combination with the safety symbols described in the preceding section.

<table>
<thead>
<tr>
<th>English</th>
<th>Francais</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAUTION</strong> Hazardous chemicals. Read the Material Safety Data Sheets (MSDSs) before handling.</td>
<td><strong>ATTENTION</strong> Produits chimiques dangereux. Lire les fiches techniques de sûreté de matériels avant la manipulation des produits.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> Hazardous waste. Refer to MSDS(s) and local regulations for handling and disposal.</td>
<td><strong>ATTENTION</strong> Déchets dangereux. Lire les fiches techniques de sûreté de matériels et la régulation locale associées à la manipulation et l’élimination des déchets.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> Hot surface.</td>
<td><strong>ATTENTION</strong> Surface brûlante.</td>
</tr>
<tr>
<td><strong>DANGER</strong> High voltage.</td>
<td><strong>DANGER</strong> Haute tension.</td>
</tr>
<tr>
<td><strong>WARNING</strong> To reduce the chance of electrical shock, do not remove covers that require tool access. No user-serviceable parts are inside. Refer servicing to Applied Biosystems qualified service personnel.</td>
<td><strong>AVERTISSEMENT</strong> Pour éviter les risques d’électrocution, ne pas retirer les capots dont l’ouverture nécessite l’utilisation d’outils. L’instrument ne contient aucune pièce réparable par l’utilisateur. Toute intervention doit être effectuée par le personnel de service qualifié de Applied Biosystems.</td>
</tr>
<tr>
<td><strong>CAUTION</strong> Moving parts.</td>
<td><strong>ATTENTION</strong> Parties mobiles.</td>
</tr>
<tr>
<td><strong>DANGER</strong> Class 3B (III) visible and/or invisible LED radiation present when open and interlocks defeated. Avoid exposure to beam.</td>
<td><strong>DANGER</strong> Rayonnement visible ou invisible d’un faisceau LED de Classe 3B (III) en cas d’ouverture et de neutralisation des dispositifs de sécurité. Evitez toute exposition au faisceau.</td>
</tr>
</tbody>
</table>

Locations of Warnings

The StepOne and StepOnePlus instruments contain a warning at the location shown below:
General Instrument Safety

**WARNING** PHYSICAL INJURY HAZARD. Using the instrument in a manner not specified by Applied Biosystems may result in personal injury or damage to the instrument.

**CAUTION** PHYSICAL INJURY HAZARD. The instrument is to be moved and positioned only by the personnel or vendor specified in the applicable site preparation guide. If you decide to lift or move the instrument after it has been installed, do not attempt to lift or move the instrument without the assistance of others, the use of appropriate moving equipment, and proper lifting techniques. Improper lifting can cause painful and permanent back injury. Depending on the weight, moving or lifting an instrument may require two or more persons.

**WARNING** Do not attempt to lift or move the computer or the monitor without the assistance of others. Depending on the weight of the computer and/or the monitor, moving them may require two or more people.

**Things to consider before lifting the computer and/or the monitor:**
- Make sure that you have a secure, comfortable grip on the computer or the monitor when lifting.
- Make sure that the path from where the object is to where it is being moved is clear of obstructions.
- Do not lift an object and twist your torso at the same time.
- Keep your spine in a good neutral position while lifting with your legs.
- Participants should coordinate lift and move intentions with each other before lifting and carrying.
- Instead of lifting the object from the packing box, carefully tilt the box on its side and hold it stationary while someone slides the contents out of the box.

**Operating the Instrument**
Ensure that anyone who operates the instrument has:
- Received instructions in both general safety practices for laboratories and specific safety practices for the instrument.
- Read and understood all applicable Material Safety Data Sheets (MSDSs). See “About MSDSs” on page xviii.

**Cleaning or Decontaminating the Instrument**
**CAUTION** Before using a cleaning or decontamination method other than those recommended by the manufacturer, verify with the manufacturer that the proposed method will not damage the equipment.
Chemical Safety

Chemical Hazard Warning

**WARNING** CHEMICAL HAZARD. Before handling any chemicals, refer to the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all relevant precautions.

**WARNING** CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Safety Guidelines

To minimize the hazards of chemicals:

- Read and understand the Material Safety Data Sheets (MSDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. (See “About MSDSs” on page xviii.)

- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For more safety guidelines, consult the MSDS.

- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For more safety guidelines, consult the MSDS.

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended in the MSDS.

- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.

About MSDSs

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with shipments of hazardous chemicals to new customers. They also provide MSDSs with the first shipment of a hazardous chemical to a customer after an MSDS has been updated. MSDSs provide the safety information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to replace the appropriate MSDS in your files.

Obtaining MSDSs

The MSDS for any chemical supplied by Applied Biosystems is available to you free 24 hours a day. To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field of the MSDS Search page:
   a. Type in the chemical name, part number, or other information that you expect to appear in the MSDS of interest.
   b. Select the language of your choice.
3. To view, download, or print the document of interest:
   a. Right-click the document title.
   b. Select:
      - Open – To view the document
      - Save Target As – To download a PDF version of the document to a destination that you choose
      - Print Target – To print the document

4. To have a copy of an MSDS sent by fax or e-mail, in the Search Results page:
   a. Select Fax or Email below the document title.
   b. Click RETRIEVE DOCUMENTS at the end of the document list.
   c. Enter the required information.
   d. Click View/Deliver Selected Documents Now.

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the chemical manufacturer.

---

**Chemical Waste Safety**

**Chemical Waste Hazard**

⚠️ **CAUTION** HAZARDOUS WASTE. Refer to Material Safety Data Sheets and local regulations for handling and disposal.

⚠️ **WARNING** CHEMICAL WASTE HAZARD. Wastes produced by Applied Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

⚠️ **WARNING** CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

**Chemical Waste Safety Guidelines**

To minimize the hazards of chemical waste:

- Read and understand the Material Safety Data Sheets (MSDSs) provided by the manufacturers of the chemicals in the waste container before you store, handle, or dispose of chemical waste.
• Provide primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)
• Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For more safety guidelines, consult the MSDS.
• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For more safety guidelines, consult the MSDS.
• Handle chemical wastes in a fume hood.
• After emptying a waste container, seal it with the cap provided.
• Dispose of the contents of the waste tray and waste bottle in accordance with good laboratory practices and local, state/provincial, or national environmental and health regulations.

Waste Disposal

If potentially hazardous waste is generated when you operate the instrument, you must:
• Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
• Ensure the health and safety of all personnel in your laboratory.
• Ensure that the instrument waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.

Electrical Safety

⚠️ DANGER ELECTRICAL SHOCK HAZARD. Severe electrical shock can result from operating the StepOne or StepOnePlus instrument without its instrument panels in place. Do not remove instrument panels. High-voltage contacts are exposed when instrument panels are removed from the instrument.

⚠️ WARNING FIRE HAZARD. Improper fuses or high-voltage supply can damage the instrument wiring system and cause a fire. Before turning on the instrument, verify that the fuses are properly installed and that the instrument voltage matches the power supply in your laboratory.

⚠️ WARNING FIRE HAZARD. For continued protection against the risk of fire, replace fuses only with fuses of the type and rating specified for the instrument.
Power

⚠️ DANGER: ELECTRICAL HAZARD. Grounding circuit continuity is vital for the safe operation of equipment. Never operate equipment with the grounding conductor disconnected.

⚠️ DANGER: ELECTRICAL HAZARD. Use properly configured and approved line cords for the voltage supply in your facility.

⚠️ DANGER: ELECTRICAL HAZARD. Plug the instrument into a properly grounded receptacle with adequate current capacity.

Overvoltage Rating

The StepOne and StepOnePlus instruments have an installation (overvoltage) category of II, and they are classified as portable equipment.

LED Safety

To ensure safe LED operation:

- The system must be maintained by an Applied Biosystems Technical Representative.
- All instrument panels must be in place on the instrument while the instrument is operating. When all panels are installed, there is no detectable radiation present. If any panel is removed when the LED is operating (during service with safety interlocks disabled), you may be exposed to LED emissions in excess of the Class 3B rating.
- Do not remove safety labels or disable safety interlocks.

Biological Hazard Safety

General Biohazard

⚠️ WARNING: BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents, and blood of humans and other animals have the potential to transmit infectious diseases. Follow all applicable local, state/provincial, and/or national regulations. Wear appropriate protective equipment, which includes but is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves. All work should be performed in properly equipped facilities using the appropriate safety equipment (for example, physical containment devices). Individuals should be trained according to applicable regulatory and company/institution requirements before working with potentially infectious materials. Read and follow the applicable guidelines and/or regulatory requirements in the following:

- U.S. Department of Health and Human Services guidelines published in Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4; http://bml.od.nih.gov)
Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your workstation to promote neutral or relaxed working positions.

⚠️ **CAUTION** MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards are caused by potential risk factors that include but are not limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

- Use equipment that comfortably supports you in neutral working positions and allows adequate accessibility to the keyboard, monitor, and mouse.
- Position the keyboard, mouse, and monitor to promote relaxed body and head postures.

Safety and Electromagnetic Compatibility (EMC) Standards

**U.S. and Canadian Safety Standards**

The StepOne and StepOnePlus instruments have been tested to and comply with standard:


UL 61010A-2-010/CAN/CSA 1010.2.010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”


**Canadian EMC Standard**

This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial, Scientific, and Medical Radio Frequency Generators.”

**European Safety and EMC Standards**

This instrument meets European requirements for safety (Low Voltage Directive 73/23/EEC). This instrument has been tested to and complies with standards EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory Use, Part 1: General Requirements.”
EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”


EMC

This instrument meets European requirements for emission and immunity (EMC Directive 89/336/EEC). This instrument has been tested to and complies with standard EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and Laboratory Use – EMC Requirements.”

Australian EMC Standards

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
Chapter 1

Get Started

This chapter covers:

■ About the StepOne™ and StepOnePlus™ Systems .................................................. 2
■ Supported Consumables .......................................................... 4
■ About Presence/Absence Experiments ....................................................... 6
■ How to Use This Guide ......................................................................... 9
■ About the Example Experiment ............................................................. 10
■ Example Experiment Workflow ............................................................... 12

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by pressing F1, clicking in the toolbar, or selecting Help ▶ StepOne Software Help.
About the StepOne™ and StepOnePlus™ Systems

There are two models available for this Real-Time PCR System:

<table>
<thead>
<tr>
<th>System</th>
<th>Features</th>
</tr>
</thead>
</table>
| Applied Biosystems StepOne™ Real-Time PCR System (StepOne™ system) | • 48-well platform  
• Three-color system |
| Applied Biosystems StepOnePlus™ Real-Time PCR System (StepOnePlus™ system) | • 96-well platform  
• Four-color system  
• VeriFlex™ sample blocks |

The StepOne and StepOnePlus systems use fluorescent-based polymerase chain reaction (PCR) reagents to provide:

- Quantitative detection of target nucleic acid sequences (targets) using real-time analysis.
- Qualitative detection of targets using post-PCR (endpoint) analysis.
- Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs post-PCR).

About Data Collection

The StepOne and StepOnePlus systems collect raw fluorescence data at different points during a PCR, depending on the type of run that the instruments perform:

<table>
<thead>
<tr>
<th>Run Type</th>
<th>Data Collection Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time runs</td>
<td>The instrument collects data following each extension step of the PCR.</td>
</tr>
<tr>
<td>Standard curve</td>
<td></td>
</tr>
<tr>
<td>Relative standard curve</td>
<td></td>
</tr>
<tr>
<td>Comparative CT (ΔΔCT)</td>
<td></td>
</tr>
<tr>
<td>Post-PCR (endpoint) runs</td>
<td>The instrument collects data:</td>
</tr>
<tr>
<td>Genotyping</td>
<td>• Before the PCR (For presence/absence experiments, data collection before the PCR is optional, but recommended.)</td>
</tr>
<tr>
<td>Presence/absence</td>
<td>• (Optional) During the PCR. The instrument can collect data during the run (real-time); collecting data during the run can be helpful for troubleshooting.</td>
</tr>
<tr>
<td></td>
<td>• After the PCR</td>
</tr>
</tbody>
</table>

Regardless of the run type, a data collection point or read on the StepOne™ or StepOnePlus™ instrument consists of three phases:

1. **Excitation** – The instrument illuminates all wells of the reaction plate within the instrument, exciting the fluorophores in each reaction.
2. **Emission** – The instrument optics collect the residual fluorescence emitted from the wells of the reaction plate. The resulting image collected by the device consists only of light that corresponds to the range of emission wavelengths.

3. **Collection** – The instrument assembles a digital representation of the residual fluorescence collected over a fixed time interval. The StepOne™ software stores the raw fluorescent image for analysis.

After a run, the StepOne software uses calibration data (spatial, dye, and background) to determine the location and intensity of the fluorescent signals in each read, the dye associated with each fluorescent signal, and the significance of the signal.

### About the Filters

The StepOne and StepOnePlus systems use the following filters:

<table>
<thead>
<tr>
<th>StepOne system</th>
<th>StepOnePlus system</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter</strong></td>
<td><strong>Dye</strong></td>
</tr>
<tr>
<td>1</td>
<td>FAM™ dye</td>
</tr>
<tr>
<td></td>
<td>SYBR® Green dye</td>
</tr>
<tr>
<td>2</td>
<td>JOE™ dye</td>
</tr>
<tr>
<td></td>
<td>VIC® dye</td>
</tr>
<tr>
<td>3</td>
<td>ROX™ dye</td>
</tr>
<tr>
<td>1</td>
<td>FAM™ dye</td>
</tr>
<tr>
<td></td>
<td>SYBR® Green dye</td>
</tr>
<tr>
<td>2</td>
<td>JOE™ dye</td>
</tr>
<tr>
<td></td>
<td>VIC® dye</td>
</tr>
<tr>
<td>3</td>
<td>TAMRA™ dye</td>
</tr>
<tr>
<td></td>
<td>NED™ dye</td>
</tr>
<tr>
<td>4</td>
<td>ROX™ dye</td>
</tr>
</tbody>
</table>

### About the VeriFlex™ Technology

The StepOnePlus instrument contains six independently thermally regulated VeriFlex™ blocks to help you optimize your thermal cycling conditions. You can set a different temperature for one or more of the VeriFlex blocks, creating up to six different zones for samples, or you can set the same temperature for each of the VeriFlex blocks.

### For More Information

For information on:
- The StepOne and StepOnePlus systems, refer to *Applied Biosystems StepOne™ Real-Time PCR Software Help*.
- Relative standard curve and/or comparative C\(T\) (\(\Delta\Delta C_T\)) experiments, refer to *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative Standard Curve and Comparative C\(T\) Experiments*.

---

**Note:** To access the Help, select **Help ‣ StepOne Software Help** from within the StepOne software.
Supported Consumables

**StepOne System** The StepOne system supports the consumables listed below. These consumables are for use with both standard and Fast reagents/protocols.

**IMPORTANT!** Use only Fast consumables (reaction plates, tube strips, and tubes) with the StepOne and StepOnePlus systems, even when performing an experiment with standard reagents.

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp™ Fast Optical 48-Well Reaction Plate</td>
<td>4375816</td>
</tr>
<tr>
<td>MicroAmp™ 48-Well Optical Adhesive Film</td>
<td>4375323 and 4375928</td>
</tr>
<tr>
<td>MicroAmp™ Fast 8-Tube Strip</td>
<td>4358293</td>
</tr>
<tr>
<td>MicroAmp™ Optical 8-Cap Strip</td>
<td>4323032</td>
</tr>
<tr>
<td>MicroAmp® Fast Reaction Tube with Cap</td>
<td>4358297</td>
</tr>
<tr>
<td>MicroAmp™ Fast 48-Well Tray</td>
<td>4375282</td>
</tr>
<tr>
<td>MicroAmp™ 48-Well Base Adaptor</td>
<td>4375284</td>
</tr>
<tr>
<td>MicroAmp™ 96-Well Support Base</td>
<td>4379590</td>
</tr>
</tbody>
</table>

# Consumable
A MicroAmp™ Fast Optical 48-Well Reaction Plate
B MicroAmp™ Fast 48-Well Tray
C MicroAmp™ 96-Well Support Base
D MicroAmp™ Optical 8-Cap Strip
E MicroAmp™ Fast 8-Tube Strip
F MicroAmp® Fast Reaction Tube with Cap
G MicroAmp™ 48-Well Optical Adhesive Film
H MicroAmp™ 48-Well Base Adaptor
The StepOnePlus system supports the consumables listed below. These consumables are for use with both standard and Fast reagents/protocols.

**IMPORTANT!** Use only Fast consumables (reaction plates, tube strips, and tubes) with the StepOne and StepOnePlus systems, even when performing an experiment with standard reagents.

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode</strong></td>
<td>4346906 and 4366932</td>
</tr>
<tr>
<td><strong>MicroAmp™ Optical Adhesive Film</strong></td>
<td>4360954 and 4311971</td>
</tr>
<tr>
<td><strong>MicroAmp™ Fast 8-Tube Strip</strong></td>
<td>4358293</td>
</tr>
<tr>
<td><strong>MicroAmp™ Optical 8-Cap Strip</strong></td>
<td>4323032</td>
</tr>
<tr>
<td><strong>MicroAmp® Fast Reaction Tube with Cap</strong></td>
<td>4358297</td>
</tr>
<tr>
<td><strong>MicroAmp™ 96-Well Tray for VeriFlex™ Blocks</strong></td>
<td>4379983</td>
</tr>
<tr>
<td><strong>MicroAmp™ 96-Well Support Base</strong></td>
<td>4379590</td>
</tr>
<tr>
<td><strong>MicroAmp™ Adhesive Film Applicator</strong></td>
<td>4333183</td>
</tr>
<tr>
<td><strong>MicroAmp™ Cap Installing Tool (Handle)</strong></td>
<td>4330015</td>
</tr>
</tbody>
</table>

---

**Notes**
About Presence/Absence Experiments

**Endpoint Experiments**

Presence/absence experiments are endpoint experiments. In endpoint experiments:
- Data are collected at the end of the PCR process.
- Reactions are characterized by the quantity of target accumulated at the end of PCR (Saiki *et al.*, 1985).
- The datapoint is the normalized intensity of the reporter dye, or Rn.

**Note:** Some endpoint experiments also include pre-PCR datapoints. If so, the system calculates the delta Rn ($\Delta$Rn) value per the following formula:

$$\Delta Rn = Rn \text{ (post-PCR read)} - Rn \text{ (pre-PCR read)}$$

where Rn = normalized reporter.

**Note:** In this guide, the term *experiment* refers to the entire process of performing a run using the StepOne or StepOnePlus system, including setup, run and analysis.

**About Presence/Absence Experiments**

Perform a presence/absence experiment to detect a specific target in a sample.

**Supported Reagents**

The StepOne and StepOnePlus systems support the following reagents for presence/absence experiments:
- TaqMan® reagents (page 7)
- Other fluorescent-based reagents (page 7)

**Note:** Presence/absence experiments are not supported for Fast master mix or Fast protocols.
TaqMan Reagents

TaqMan reagents use a fluorogenic probe to enable detection of a target sequence (unknown target) and IPC sequence (IPC target). During amplification, the unknown target and the IPC target generate reporter fluorescence signals such that positive or negative calls can be made on samples (Saiki et al., 1985).

<table>
<thead>
<tr>
<th>TaqMan® Reagents or Kits</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advantages</strong></td>
<td></td>
</tr>
<tr>
<td>• Increased specificity with the addition of a fluorogenic probe.</td>
<td></td>
</tr>
<tr>
<td>• Provides multiplex capability.</td>
<td></td>
</tr>
<tr>
<td>• Preformulated assays, optimized to run under universal thermal cycling conditions, are available.</td>
<td></td>
</tr>
<tr>
<td><strong>Limitations</strong></td>
<td></td>
</tr>
<tr>
<td>Requires synthesis of a unique fluorogenic probe.</td>
<td></td>
</tr>
</tbody>
</table>

**Other Reagents**

If you use other fluorescent-based reagents on the StepOne and StepOnePlus systems, note the following:

- You must design your experiment using Advanced Setup instead of the Design Wizard. (See “Advanced Setup Workflow” on page 110.)
- For Applied Biosystems TaqMan reagents, the StepOne software automatically calculates reaction volumes in the Reaction Setup screen.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as a reporter or quencher with the StepOne system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus system.

**About the PCR Reactions**

With presence/absence experiments, you prepare PCR reactions that contain primers and probes to amplify the target and a reagent to detect amplification of the target. You can set up the PCR reactions for the presence/absence experiments three different ways:
IPC setup – Use an internal positive control (IPC) to monitor the PCR progress and ensure that a negative result is not caused by failed PCR in the sample. PCR reactions contain two primer/probe sets: One to detect the unknown target (unknown target primer set and TaqMan probe to detect the unknown target) and one to detect the IPC (IPC primer set and a VIC dye-labeled TaqMan probe to detect the IPC template). With this setup, there are three well types:

- **Unknown-IPC wells** – Wells contain sample template and IPC template; the presence of the target is not known.
- **Negative control-IPC wells** – Wells contain IPC template and water or buffer instead of sample template in the PCR reaction. Only the IPC template should amplify in negative control-IPC wells because the reaction contains no sample template. Also called *IPC+*.
- **Negative control-blocked IPC wells** – Wells contain IPC blocking agent instead of sample template in the PCR reaction. No amplification should occur in negative control-blocked IPC wells because the reaction contains no sample template and amplification of the IPC is blocked. Also called *no amplification control (NAC)*.

No IPC, singleplex setup – Use Advanced Setup to omit the IPC from your presence/absence experiment. PCR reactions contain one primer/probe set. PCR reactions do not contain the IPC. With this setup, there are two well types:

- **Unknown wells** – Wells contain sample template; the presence of the target is not known.
- **Negative controls** – Wells contain water or buffer instead of sample template.

No IPC, multiplex setup – Use Advanced Setup to omit the IPC from your presence/absence experiment and detect two targets in one reaction. PCR reactions contain two primer/probe sets. PCR reactions do not include the IPC. With this setup, there are two well types:

- **Unknown-Unknown wells** – Wells contain sample template; the presence of the target is not known.
- **Negative control-Negative control wells** – Wells contain water or buffer instead of sample template.

About the Instrument Run

With presence/absence experiments, the instrument runs can include:

- **Pre-PCR read** – Perform the pre-PCR read on the StepOne or StepOnePlus instrument before PCR amplification to collect baseline fluorescence data.
- **Amplification** – Perform amplification on the StepOne or StepOnePlus instrument to collect fluorescence data during PCR amplification. If you do not include amplification in the run method, you need to perform amplification on another instrument.
- **Post-PCR read** – The post-PCR read is required to determine the results for presence/absence experiments. Perform the post-PCR read on the instrument after PCR amplification to collect endpoint fluorescence data.

Fluorescence data collected during the instrument run are stored in an experiment data file (.eds).
About the Analysis

Data from the instrument run are used to determine presence/absence calls. Results are plotted in a presence/absence plot. If the experiment includes amplification, results are plotted in an amplification plot.

**Pre-PCR read** – If included, the data collected from the pre-PCR read can be used to normalize data collected from the post-PCR read.

**Amplification** – If included, the data collected from the amplification can be used to troubleshoot.

**Post-PCR read** – The data collected from the post-PCR read are used to make presence/absence calls:

- **Presence** – The target amplified above the target’s threshold. The target is present in the sample.
- **Absence** – The target did not amplify above the target’s threshold. The target is absent in the sample.
- **Unconfirmed**

With the IPC setup, the data collected from the post-PCR read are used to make the following calls:

- **IPC Failed** – The IPC target did not amplify in the IPC wells and/or the IPC target amplified in the blocked IPC wells.
- **IPC Succeeded** – The IPC target amplified in the IPC wells and the IPC target did not amplify in the blocked IPC wells.

How to Use This Guide

This guide functions as both a tutorial and as a guide for performing your own experiments.

**Using This Guide as a Tutorial**

Using example experiment data provided with the StepOne software, you can use this guide as a tutorial for performing a presence/absence experiment on a StepOne or StepOnePlus system. Follow the procedures in chapters 2 to 5:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Design the experiment using the Design Wizard in the StepOne software.</td>
</tr>
<tr>
<td>3</td>
<td>Prepare the experiment, using the reagents and volumes calculated by the Design Wizard in Chapter 2.</td>
</tr>
<tr>
<td>4</td>
<td>Run the experiment on a StepOne or StepOnePlus instrument (standalone or colocated layout).</td>
</tr>
<tr>
<td>5</td>
<td>Analyze the results.</td>
</tr>
</tbody>
</table>

For more information, see “About the Example Experiment” on page 10.
Using This Guide With Your Own Experiments

After completing the tutorial exercises in Chapter 2 to 5, use this guide to lead you through your own presence/absence experiments. Each procedure in Chapters 2 to 5 includes a set of guidelines that you can use to perform your own experiments.

Additionally, you can use one of the other workflows provided in the StepOne software to perform your experiments. The table below provides a summary of all the workflows available in the StepOne software.

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Wizard</td>
<td>Set up a new experiment with guidance from the software. The Design Wizard walks you through best practices as you create your own experiment. The Design Wizard is recommended for new users. Note: Design options are more limited in the Design Wizard than in Advanced Setup.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Advanced Setup</td>
<td>Set up a new experiment using advanced options. Advanced Setup allows design flexibility as you create your own experiment. Advanced Setup is recommended for experienced users.</td>
<td>page 110</td>
</tr>
<tr>
<td>QuickStart</td>
<td>Run a new experiment with no plate setup information. If desired, you can add all design parameters after the run.</td>
<td>page 111</td>
</tr>
<tr>
<td>Template</td>
<td>Set up a new experiment using setup information from a template.</td>
<td>page 113</td>
</tr>
<tr>
<td>Export/Import</td>
<td>Import experiment designs from ASCII text files that contain experiment setup information.</td>
<td>page 115</td>
</tr>
</tbody>
</table>

About the Example Experiment

To illustrate how to perform presence/absence experiments, this guide leads you through the process of designing, preparing, running and analyzing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with a StepOne or StepOnePlus system.

Description of the Presence/Absence Experiment

The objective of the presence/absence example experiment is to determine if a pathogen is present or absent in each batch of ground beef.

In the presence/absence example experiment:
- DNA is extracted from samples using the PrepMan® Ultra Sample Preparation Reagent. The DNA is extracted from bacteria found in five samples of ground beef.
- The target is a pathogen.
- The experiment is designed for duplex PCR, where each reaction contains two primer/probe sets. One set detects the unknown target (primer set and FAM™ dye-labeled probe to amplify and detect the target sequence.) The other primer/probe set detects the IPC primer set and VIC® dye-labeled TaqMan probe amplifies and detects the IPC template.
About the Example Experiment Data

In this getting started guide you will use two files:

- In Chapter 2, you will create a presence/absence example experiment file that contains setup data and save it to the experiments folder on your computer:

  `<drive>:\Applied Biosystems\<software name>\experiments\Presence Absence Example.eds`
• In Chapter 5, you will view results in a presence/absence example experiment file that contains run data. The data file for the example experiment installs with the StepOne software. You can find the data file for the example experiment on your computer:

<drive>:\Applied Biosystems\<software name>\experiments\examples\Presence Absence Example.eds

where:
• <drive> is the computer hard drive on which the StepOne software is installed. The default installation drive for the software is the D drive.
• <software name> is the current version of the StepOne software.

Data Files in the Examples Folder
The examples folder contains several data files that you can reference when analyzing your own data, as listed below. The data files install with the StepOne software.

Note: Be sure to use the Presence Absence Example.eds file when performing the tutorial procedures in this guide. The 96-Well Presence Absence Example.eds file is a different example of a presence/absence experiment.

<table>
<thead>
<tr>
<th>StepOne Instrument</th>
<th>StepOnePlus Instrument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparative CT Example.eds</td>
<td>96-Well Comparative CT Example.eds</td>
</tr>
<tr>
<td>Multiplex Example.eds</td>
<td>96-Well Multiplex Example.eds</td>
</tr>
<tr>
<td>Genotyping Example.eds</td>
<td>96-Well Genotyping Example.eds</td>
</tr>
<tr>
<td>Presence Absence Example.eds</td>
<td>96-Well Presence Absence Example.eds</td>
</tr>
<tr>
<td>Relative Standard Curve Example.eds</td>
<td>96-Well Relative Standard Curve Example.eds</td>
</tr>
<tr>
<td>RNase P Experiment.eds</td>
<td>96-Well RNase P Experiment.eds</td>
</tr>
<tr>
<td>Standard Curve Example.eds</td>
<td>96-Well Standard Curve Example.eds</td>
</tr>
<tr>
<td>SYBR Example.eds</td>
<td>96-Well SYBR Example.eds</td>
</tr>
</tbody>
</table>

Example Experiment Workflow

The figure on page 13 shows the workflow for the presence/absence example experiment.
Design the Experiment (Chapter 2)
1. Create a new experiment.
2. Define the experiment properties.
3. Define the methods and materials.
4. Set up the targets.
5. Set up the samples.
6. Set up the run method.
7. Set up the reactions.
8. Order materials for the experiment.

Prepare the Reactions (Chapter 3)
1. Prepare the template.
2. Prepare the samples.
3. Prepare the reaction mix.
4. Prepare the reactions.

Run the Experiment (Chapter 4)
1. Prepare for the run.
2. (Optional) Enable the notification settings.
3. Start the run.
4. Monitor the run.
5. Unload the instrument and transfer the data.

Analyze the Experiment (Chapter 5)
Section 1, Review Results:
1. Analyze the experiment.
2. View the presence/absence plot.
3. View the amplification plot.
4. View the results in a table.
5. Publish the data
Section 2, Troubleshoot (If Needed):
1. View the analysis settings.
2. View the quality summary.
3. Omit wells.
4. View the multicomponent plot.
5. View the raw data plot.
Design the Experiment

This chapter covers:

- Chapter Overview ................................................................. 16
- Create a New Experiment ......................................................... 17
- Define the Experiment Properties ............................................ 20
- Define the Methods and Materials ........................................... 23
- Set Up the Targets ................................................................. 25
- Set Up the Samples and Replicates ......................................... 26
- Set Up the Run Method .......................................................... 29
- Review the Reaction Setup ...................................................... 31
- Order Materials for the Experiment ......................................... 35
- Finish the Design Wizard ........................................................ 38

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by pressing F1, clicking ☰ in the toolbar, or selecting Help > StepOne Software Help.
Chapter Overview

This chapter explains how to use the Design Wizard in the StepOne™ software to set up the presence/absence example experiment. The Design Wizard walks you through Applied Biosystems recommended best practices as you enter design parameters for the example experiment.

Example Experiment Workflow

The workflow for designing the example experiment provided with this getting started guide is shown below.

Note: Design the example experiment using the Design Wizard in the StepOne software. When you design your own experiments, you can select alternate workflow (see “Using This Guide With Your Own Experiments” on page 10).

Start Experiment

1. Design the Experiment (Chapter 2)
   1. Create a new experiment.
   2. Define the experiment properties.
   3. Define the methods and materials.
   4. Set up the targets.
   5. Set up the samples.
   6. Set up the run method.
   7. Review the reaction setup.
   8. Order materials for the experiment.

Prepare the Reactions (Chapter 3)

Run the Experiment (Chapter 4)

Analyze the Experiment (Chapter 5)

End Experiment
Create a New Experiment

Create a new experiment using the Design Wizard in the StepOne software.

1. Double-click (StepOne software shortcut) or select Start ▶ All Programs ▶ Applied Biosystems ▶ StepOne Software ▶ <software name>
where <software name> is the current version of the StepOne software.

2. From the Home screen, select Design Wizard to open the Design Wizard.

3. See “Software Elements” below for information on navigating within the Design Wizard.
Software Elements

The StepOne software elements for the Design Wizard are illustrated below.

1. **Menu bar** – Displays the menus available in the software:
   - File
   - Edit
   - Instrument
   - Analysis
   - Tools
   - Help

2. **Toolbar** – Displays the tools available in the software:
   - New Experiment
   - Open
   - Save
   - Close
   - Send Experiment to Instrument
   - Download Experiment from Instrument
   - Export
   - Print Report

3. **Experiment header** - Displays the experiment name, experiment type, and reagents for the open experiment.

4. **Navigation pane** – Provides links to all screens in the Design Wizard:
   - Experiment Properties
   - Methods & Materials
   - Targets
   - Samples & Replicates
   - Run Method
   - Reaction Setup
   - Materials List

**Note:** The Design Wizard initially displays the Quantitation - Standard Curve experiment type. The available Design Wizard screens may change when you select a different experiment type. For example, the Samples & Replicates screen is not displayed until you select the presence/absence experiment type.

5. **Experiment tab(s)** – Displays a tab for each open experiment.
Chapter 2 Design the Experiment
Create a New Experiment

1. Define Experiment Properties
   - Instructions: Enter an experiment name, select the instrument type, and choose the type of experiment to design.
   - Name: New
   - Barcode (optional): 
   - User Name (optional): 
   - Comments (optional): 

2. Set Up
   - Which instrument are you using to run the experiment?
     - StepOnePlus™ Instrument (8 Wells)
     - StepOne™ Instrument (96 Wells)
   - Set up, run, and analyze the experiment using a 96-well format.

3. What type of experiment do you want to design?
   - Quantity
   - Genotyping
   - Presence/Absence

4. Design a gene expression experiment to determine the amount of target nucleic acid sequence in a sample.

Notes
Define the Experiment Properties

On the Experiment Properties screen, enter identifying information for the experiment, select the instrument type, then select the type of experiment to design.

About the Example Experiment

In the presence/absence example experiment:
- The experiment is identified as an example.
- The instrument selected to run the experiment is the StepOne instrument.
- A MicroAmp™ Fast Optical 48-Well Reaction Plate is used.
- The experiment type is presence/absence.

Complete the Experiment Properties Screen

1. Click the Experiment Name field, then enter Presence Absence Example.
   
   Note: The experiment header updates with the experiment name you entered.

2. Leave the Barcode field empty.
   
   Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

3. Click the User Name field, then enter Example User.

4. Click the Comments field, then enter Presence Absence Getting Started Guide Example.

5. Select StepOne™ Instrument (48 Wells).
   
   Note: The example experiment was created for a StepOne instrument. You can create the example experiment for a StepOnePlus instrument; however, your reaction plate layout will differ from the layout shown in this guide. The software displays a 48-well reaction plate layout for the StepOne instrument and a 96-well reaction plate layout for the StepOnePlus instrument. To create the example experiment for a StepOnePlus instrument, select StepOnePlus™ Instrument (96 Wells).

6. Select Presence/Absence for the experiment type.

7. Click Next →.

Notes
Design Guidelines

When you design your own presence/absence experiment:

- Enter an experiment name:
  - Enter a name that is descriptive and easy to remember. You can enter up to 100 characters in the Experiment Name field.
  - The experiment name is used as the default file name.

  **Note:** You cannot use the following characters in the Experiment Name field: forward slash (/), backslash (\), greater than sign (＞), less than sign (＜), asterisk (*) question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

- (Optional) If you are using a MicroAmp™ Fast Optical 96-Well Reaction Plate, enter a barcode to identify the barcode on the reaction plate. You can enter up to 100 characters in the Barcode field.

  **Note:** The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

- (Optional) Enter a user name to identify the owner of the experiment. You can enter up to 100 characters in the User Name (Optional) field.

- (Optional) Enter comments to describe the experiment. You can enter up to 1000 characters in the Comments field.
Chapter 2: Design the Experiment

Define the Experiment Properties

22 Presence/Absence Experiments

- Select the instrument you are using to run the experiment:
  - StepOne™ Instrument (48 Wells)
  - StepOnePlus™ Instrument (96 Wells)

**Note:** You can use StepOne Software v2.0 or later to design experiments for both the StepOne and StepOnePlus instruments. The instrument you select in the Experiment Properties screen affects the reaction plate layout and materials list.

**Note:** To set the default instrument type, select Tools > Preferences, then select the General tab (default). From the Default Instrument Type dropdown menu, select the appropriate instrument.

- Select Presence/Absence as the experiment type.

For More Information

For more information on:
- Completing the Experiment Properties screen, access the StepOne Software Help by clicking ? or pressing F1.
- Consumables, see “Order Materials for the Experiment” on page 35.
- Presence/absence experiments, refer to the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide.
Define the Methods and Materials

On the Methods & Materials screen, view the reagents, DNA template and ramp speed to use for the experiment.

About the Example Experiment

In the presence/absence example experiment:

- TaqMan reagents are used.
- The standard ramp speed is used in the instrument run.
- DNA template is the type of nucleic acid sample added to the PCR reactions.

Complete the Methods & Materials Screen

1. Make sure TaqMan® Reagents is displayed for the reagents.
2. Make sure DNA is displayed for the template type.
3. Make sure Standard (~2 hours to complete a run) is displayed for the ramp speed.
4. Make sure Pre-PCR Read and Amplification are selected for the stages.
5. Click Next →.

Notes
Design Guidelines

When you design your own presence/absence experiment:

- **TaqMan Reagents** use a TaqMan probe to detect amplification of the target. In the presence/absence experiments, TaqMan reagents consist of two primer/probe sets. The primers are designed to amplify the target and the IPC template. The TaqMan probes are designed to hybridize to the target and the IPC and generate fluorescence signal when the target and IPC are amplified.

**Note:** Applied Biosystems recommends that you use TaqMan reagents for presence/absence experiments. If you want to use other reagents, use Advanced Setup to set up your experiment.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as a reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

- DNA template is used in the presence/absence experiment.
- Select the **Standard** ramp speed for the instrument run.

**IMPORTANT!** The Design Wizard does not support Fast ramp speeds for presence/absence experiments. If you want to use Fast ramp speeds, use Advanced Setup to set up your experiment.

- Select the appropriate stages for the instrument run:
  - **Pre-PCR Read** – If you do not want to collect data before amplification, deselect the Pre-PCR Read checkbox.
    **Note:** Applied Biosystems recommends that you include the pre-PCR read in the StepOne or StepOnePlus instrument run.
  - **Amplification** – If you want to perform amplification on a thermal cycler, deselect the Amplification checkbox.
    **Note:** Applied Biosystems recommends that you include the amplification stage in the StepOne or StepOnePlus instrument run. You can use the data collected during amplification to troubleshoot.
  - **Post-PCR Read** – This required stage is preselected for you.

For More Information

For more information on:
- Completing the Methods & Materials screen, access the StepOne Software Help by clicking 📖 or pressing F1.
- TaqMan reagents, refer to the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide.*
- Using Advanced Setup, see “Advanced Setup Workflow” on page 110.
- PCR, including singleplex vs. multiplex PCR refer to the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide.*

Notes
Set Up the Targets

On the Targets screen, enter the name of the target you want to detect in the PCR reaction plate (Unknown), then enter the name of the internal positive control (IPC) target.

In the presence/absence example experiment:
- A pathogen is used as the unknown target and an IPC is used as the IPC target. The IPC target ensures that a negative result is not the result of a failed PCR reaction.
- Each well in the reaction plate contains an IPC.

About the Example Experiment

Complete the Targets Screen

1. Click the **What is the name of the target you want to detect (Unknown)?** field, then enter **Pathogen**.

2. Click the **What is the name of the IPC target?** field, then enter **IPC**.

**Note:** The Targets Used in Experiment table updates with the target names.

3. Leave the default colors in the Color dropdown menus.

4. Click **Next**.

---

Notes
Design Guidelines

When you design your own presence/absence experiment:

- Identify the target and the IPC with a unique name and color. You can enter up to 100 characters for the unknown target name and the IPC target name.
- In the Design Wizard, the unknown target is detected using a FAM dye-labeled TaqMan probe and the IPC target is detected using a VIC dye-labeled TaqMan probe.

Note: If you want to set up your presence/absence experiments without the IPC, perform advanced setup. See “Advanced Setup Workflow” on page 110.

For More Information

For more information on completing the Targets screen, access the StepOne Software Help by clicking @ or pressing F1.

Set Up the Samples and Replicates

On the Samples & Replicates screen, enter the number of samples, replicates, and negative controls to include in the reaction plate, enter the sample names, then select which sample/target reactions to set up.

About the Example Experiment

In the presence/absence example experiment:

- Five samples are used. In the samples, the presence/absence of the target (a pathogen) is unknown.
- Eight Unknown-IPC replicates are used. Replicates are identical to the sample reactions, containing identical components and volumes.
- Four Negative Control-Blocked IPC replicates are used. Replicates contain IPC template and IPC blocking agent instead of sample template.
- Four Negative Control-IPC replicates are used. Replicates contain IPC template and buffer or water instead of sample template.

Complete the Samples & Replicates Screen

1. Click the How many samples do you want to test in the reaction plate? field, then enter 5.
2. In the Enter Sample Name fields, enter:
   - Unknown 1
   - Unknown 2
   - Unknown 3
   - Unknown 4
   - Unknown 5
3. Leave the default colors in the Color dropdown menus.
4. Click the How many replicates do you need for reactions that contain sample? (Unknown-IPC wells) field, then enter 8.

Notes
5. Click the **How many replicates do you need for reactions that contain IPC blocking agent instead of sample? (Negative Control-Blocked IPC wells)** field, then enter 4.

6. Click the **How many replicates do you need for reactions that contain water or buffer instead of sample? (Negative Control-IPC wells)** field, then enter 4.

7. In the Well Count pane, confirm that there are:
   - 40 Unknown-IPC
   - 4 Negative Control-Blocked IPC
   - 4 Negative Control-IPC
   - 0 Empty

8. In the View Plate Layout pane:
   a. From the Arrange Plate by dropdown menu, select **Rows**.
   b. From the Place Negative Controls in dropdown menu, select **Upper Left**.

9. Click **Next**

---

**Design Guidelines**

When you design your own presence/absence experiment:

- Identify each sample with a unique name and color. You can enter up to 100 characters in the Sample Name field.
- Enter the number of Unknown-IPC replicates to set up. Applied Biosystems recommends 3 Unknown-IPC replicates.
- Enter the number of Negative Control-Blocked IPC replicates to set up. Applied Biosystems recommends 3 Negative Control-Blocked IPC replicates.
- Enter the number of Negative Control-IPC replicates to set up. Applied Biosystems recommends 3 Negative Control-IPC replicates.
- If the number of reactions required exceeds the number of wells in the reaction plate, reduce the number of samples, Unknown-IPC replicates, Negative Control-Blocked IPC replicates, and/or Negative Control-IPC replicates.
- If you are running the experiment on a StepOnePlus instrument and plan to edit the Run Method (page 29) to set a different temperature for one or more of the VeriFlex blocks, you need to:
  b. In the Plate Setup screen, select the Assign Targets and Samples tab, select the View Plate Layout tab, then select the Enable VeriFlex™ Block checkbox.

IMPORTANT! If you do not select the Enable VeriFlex™ Block checkbox in the Plate Setup screen, you will not be able to set a different temperature for one or more of the VeriFlex blocks in the Run Method screen (page 29).

For More Information  For more information on completing the Samples & Replicates screen, access the StepOne Software Help by clicking 🕵️ or pressing F1.
Chapter 2 Design the Experiment
Set Up the Run Method

On the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method, or replace it with one
from the library.

About the Example Experiment

In the presence/absence example experiment, the default run method is used without
edits.

Review the Run Method Screen

1. Click either the Graphical View tab (default) or Tabular View tab.
2. Make sure the Reaction Volume Per Well field displays 20 µL.
3. Make sure the Pre-PCR Read and Amplification checkboxes are selected.
4. Make sure the thermal profile displays the holding and cycling stages shown below.
5. Click Next →.

Design Guidelines

When you design your own presence/absence experiment:

- Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
  StepOnePlus systems support reaction volumes from 10 to 30 µL.
- Review the thermal profile to make sure that it is appropriate for your reagents.

If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the StepOne software.

Notes
• If you are running the experiment on a StepOnePlus instrument and you want to set a different temperature for one or more of the VeriFlex blocks, you need to:
  
b. In the Plate Setup screen (page 28), select the Assign Targets and Samples tab, select the View Plate Layout tab, then select the Enable VeriFlex™ Block checkbox.

**IMPORTANT!** If you do not select the Enable VeriFlex™ Block checkbox in the Plate Setup screen, you will not be able to set a different temperature for one or more of the VeriFlex blocks in the Run Method screen.

c. In the Run Method screen, select the Graphical View tab.
d. For each VeriFlex™ block you want to change, click the temperature, then enter the desired value.

**Note:** You can set a different temperature for one or more of the VeriFlex blocks, or set each of the VeriFlex blocks to the same temperature. If neighboring VeriFlex blocks are not set to the same temperature, the temperature difference must be between 0.1 and 5.0 °C. The maximum temperature is 99.9 °C.

**For More Information**

For more information on:

- The run method library or completing the Run Method screen, access the StepOne Software Help by clicking 📚 or pressing F1.
- Setting temperatures for the VeriFlex blocks, access the StepOne Software Help by clicking 📚 or pressing F1.
- Using Advanced Setup, see “Advanced Setup Workflow” on page 110.
Review the Reaction Setup

On the Reaction Setup screen, select the assay type, then review the calculated volumes for preparing the samples, controls, and PCR reactions.

IMPORTANT! Perform these steps for each target in the reaction plate.

About the Example Experiment

In the presence/absence example experiment:

- The assay type is Inventoried/Made to Order
- The reaction volume per well is 20 µL with a 10% excess.
- The reaction components are:
  - TaqMan Universal PCR Master Mix (2.0X)
  - IPC Mix (10X)
  - IPC DNA (50X)
  - Primer/Probe Mix (20.0X)
  - Water
- For all samples:
  - The stock concentration of sample DNA is 100.0 ng/µL.
  - The sample DNA is diluted to a concentration of 50.0 ng/µL.
  - The diluted sample DNA (50.0 ng/µL) is at a 10X concentration: 2 µL is used to prepare a 20-µL reaction.
  - The final concentration of sample DNA in the reactions is 5.0 ng/µL.

Complete the Reaction Setup Screen

1. Select the Reaction Mix Calculations tab (default).
2. Make sure the Assay Type field displays Inventoried/Made to Order.
3. Make sure the Reaction Volume Per Well field displays 20 µL.
4. Make sure the Excess Reaction Volume field displays 10%.
5. In the Reaction Mix Pane:
   a. Make sure the Master Mix Concentration field displays 2.0X.
   b. Make sure the Primer/Probe Mix Concentration field displays 20.0X.
c. Review the components and calculated volumes for the PCR reactions:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (µL) for 1 Reaction</th>
<th>Volume (µL) for 48 Reactions (Including Excess)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Mix (2.0X)</td>
<td>10.0</td>
<td>528.0</td>
</tr>
<tr>
<td>10X IPC Mix</td>
<td>2.0</td>
<td>105.6</td>
</tr>
<tr>
<td>50X IPC DNA</td>
<td>0.4</td>
<td>21.1</td>
</tr>
<tr>
<td>Primer/Probe Mix (20.0X)</td>
<td>1.0</td>
<td>52.8</td>
</tr>
<tr>
<td>H₂O</td>
<td>4.6</td>
<td>242.9</td>
</tr>
<tr>
<td><strong>Total Volume</strong></td>
<td><strong>18.0</strong></td>
<td><strong>950.4</strong></td>
</tr>
</tbody>
</table>

6. In the Control & Sample Volume pane, review the calculated volumes for preparing the reactions:

<table>
<thead>
<tr>
<th>Well Type</th>
<th>Component</th>
<th>Volume (µL) for 1 Reaction</th>
<th># of Wells</th>
<th>Total Volume (µL) Added per Well Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative Control-Blocked IPC</td>
<td>10X IPC Block</td>
<td>2.0</td>
<td>4</td>
<td>8.8</td>
</tr>
<tr>
<td>Negative Control-IPC</td>
<td>1X TE or Water</td>
<td>2.0</td>
<td>4</td>
<td>8.8</td>
</tr>
<tr>
<td>Unknown 1</td>
<td>Sample DNA (10X)</td>
<td>2.0</td>
<td>8</td>
<td>17.6</td>
</tr>
<tr>
<td>Unknown 2</td>
<td>Sample DNA (10X)</td>
<td>2.0</td>
<td>8</td>
<td>17.6</td>
</tr>
</tbody>
</table>

Notes: ____________________________
Complete the Sample Dilution Calculations Tab

1. Select the **Sample Dilution Calculations** tab.

2. Click the **Diluted Sample Concentration (10X for Reaction Mix)** field, then enter **50.0**.

3. From the unit dropdown menu, select **ng/µL** (default).

4. Review the calculated volumes for the sample dilutions:

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Stock Concentration (ng/µL)</th>
<th>Sample Volume (µL)</th>
<th>Diluent Volume (µL)</th>
<th>Total Volume of Diluted Sample (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown 1</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>Unknown 2</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>Unknown 3</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>Unknown 4</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>Unknown 5</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
</tbody>
</table>
Print Reaction Setup Instructions

Print detailed reaction setup instructions, then save the instructions for Chapter 3.

1. Click Print Reaction Setup.

2. In the dialog box, select:
   - Detailed Reaction Setup Instructions
   - Include Plate Layout
   - Use sample color

3. Click Print to send the reaction setup instructions to your printer.

4. Click Next.

Design Guidelines

When you design your own presence/absence experiment:

- Select the type of assay you are using:
  - **Inventoried/Made to Order**— The primers and TaqMan probe are provided together in one ready-to-use assay mix.
  - **Custom**— The primers and TaqMan probe are designed and provided separately.
- Enter a number from 10 to 30 for the reaction volume/well. The StepOne and StepOnePlus systems support reaction volumes from 10 to 30 µL.
- Include excess reaction volume to account for the loss that occurs during pipetting. Applied Biosystems recommends an excess reaction volume of at least 10%.
- Review the components and calculated volumes for the PCR reactions. If needed, edit the master mix and primer/probe mix concentrations.

For More Information

For more information on completing the Reaction Setup screen, access the StepOne Software Help by clicking F1 or pressing F1.
Order Materials for the Experiment

On the Materials List screen, review the list of materials recommended to prepare the PCR reaction plate. (Optional) Print the materials list, create a shopping list, then order the recommended materials from the Applied Biosystems Store.

**Note:** To access the Applied Biosystems Store, you need to have an Internet connection. Product availability and pricing may vary according to your region or country. Online ordering through the Applied Biosystems Store is not available in all countries. Contact your local Applied Biosystems representative for help.

**Note:** The StepOne software recommends the materials to order based on your experiment design. It is assumed that you will design your experiment, order your materials, then prepare (Chapter 3) and run (Chapter 4) the reaction plate when your materials arrive.

### About the Example Experiment

In the presence/absence example experiment, the recommended materials are:

- MicroAmp™ Fast Optical 48-Well Reaction Plate
- MicroAmp™ 48-Well Optical Adhesive Film
- MicroAmp™ 96-Well Support Base
- TaqMan® Universal PCR Master Mix (2×)

**Note:** The example experiment was created for a StepOne instrument. If you selected the StepOnePlus instrument in the Experiment Properties screen (page 20), the 96-well consumables (for example, the MicroAmp™ Fast Optical 96-Well Reaction Plate) are listed in place of the 48-well consumables.

### Complete the Experiment Materials List Screen

1. From the Display dropdown menu, select **All Items** (default), then review the recommended materials. If needed, use the scroll bar at right to see all items.

   **Note:** For more information on a specific item, click the part number link. You will be connected to the product information page on Applied Biosystems Store. To access the Applied Biosystems Store, you need to have an Internet connection.

2. *(Optional)* Click **Print Materials List** to send the materials list to your printer.

3. *(Optional)* Create a shopping list:

   a. Select the checkbox next to each of the following items:
      - MicroAmp™ Fast Optical 48-Well Reaction Plate
      - MicroAmp™ 48-Well Optical Adhesive Film
      - MicroAmp™ 96-Well Support Base
      - TaqMan® Universal PCR Master Mix (2×)

   b. Click **Add Selected Items to Shopping List**.
4. **(Optional)** Create a shopping basket on the Applied Biosystems Store:

   **Note:** To access the Applied Biosystems Store, you need to have an Internet connection. Product availability and pricing may vary according to your region or country. Online ordering through the Applied Biosystems Store is not available in all countries. Contact your local Applied Biosystems representative for help.

   a. Check that the Experiment Shopping List contains the desired materials and that the quantities are correct, then click **Order Materials in List**.

   b. In the Order Materials - Log In dialog box, enter your user name and password for the Applied Biosystems Store, then click **Login and Submit**.

      **Note:** If you do not have an account with the Applied Biosystems Store, click **Register Now** to create an account.

   c. When you are connected to the Applied Biosystems Store, follow the prompts to complete your order.

5. Go to “Finish the Design Wizard” on page 38.
When you design your own presence/absence experiment:

- Select all the materials you require for your experiment and add them to your shopping list.

- To access the Applied Biosystems Store:
  - Confirm that your computer has an Internet connection.
  - Applied Biosystems recommends the following browsers and Adobe® Acrobat® Reader versions to use the Applied Biosystems web site:

<table>
<thead>
<tr>
<th>Desktop Operating System</th>
<th>Netscape® Navigator</th>
<th>Microsoft® Internet Explorer</th>
<th>Macintosh® Safari</th>
<th>Adobe® Acrobat® Reader</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® 2000/NT/XP/Vista</td>
<td>v6.x or later</td>
<td>v6.x or later</td>
<td>Not applicable</td>
<td>v4.0 or later</td>
</tr>
<tr>
<td>Macintosh® OS 9+ or later</td>
<td>Not supported</td>
<td>Not supported</td>
<td>v2.0.4 or later</td>
<td>v4.0 or later</td>
</tr>
</tbody>
</table>

**Note:** Make sure that cookies and Java Script are turned on for the web site to function correctly.

For more information on completing the Experiment Materials List screen, access the StepOne Software Help by clicking ⬇️ or pressing F1.
Finish the Design Wizard

To finish the Design Wizard, review the plate layout, then select an exit option.

The StepOne software automatically selects locations for the wells in the reaction plate. In the presence/absence experiment:

- The wells are arranged as shown below.

**Note:** The example experiment was created for a StepOne instrument. If you selected the StepOnePlus instrument in the Experiment Properties screen (page 20), your reaction plate layout will differ from the layout shown above. The software displays a 96-well reaction plate layout for the StepOnePlus instrument. For an example of the 96-well reaction plate layout, see page 11.

- The experiment is saved as is and closed.

**Note:** For the example experiment, do not perform the run at this time.
1. At the bottom of the StepOne software screen, click **Finish Designing Experiment**.

2. In the Review Plate for Experiment window, review the plate layout. Make sure there are:
   - 40 Unknown-IPC
   - 4 Negative Control-Blocked IPC
   - 4 Negative Control-IPC
   - 0 Empty

   **Note:** If the plate layout is incorrect, click **Return to the Wizard** and check your entered values.

3. Click **Save Experiment**.

4. In the Save Experiment dialog box, click **Save** to accept the default file name and location. The example experiment is saved and closed, and you are returned to the Home screen.

   **Note:** By default, the example experiment is saved to the `<drive>:\Applied Biosystems\<software name>\experiments` folder.
When you design your own presence/absence experiment:

- In the Review Plate for Experiment window, select the appropriate exit option:

<table>
<thead>
<tr>
<th>Click</th>
<th>if you want to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Experiment</td>
<td>save and close the experiment without making any further changes or starting the run.</td>
</tr>
<tr>
<td>Start Run for This Experiment</td>
<td>save the experiment and start the run. Make sure the reaction plate is loaded in the instrument.</td>
</tr>
<tr>
<td>Edit Plate Layout</td>
<td>• use advanced setup to edit the plate layout.</td>
</tr>
<tr>
<td></td>
<td>• (StepOnePlus instrument only) set a different temperature for one or more of the VeriFlex blocks using Advanced Setup.</td>
</tr>
<tr>
<td>Create Another Experiment Using the Design Wizard</td>
<td>save and close the current experiment, then create another experiment using the Design Wizard.</td>
</tr>
<tr>
<td>Return to the Wizard</td>
<td>return to the experiment to make changes using the Design Wizard.</td>
</tr>
</tbody>
</table>

- By default, experiments are saved to the `<drive>:\Applied Biosystems\<software name>\experiments` folder. To change the:
  - Save location for a specific experiment, navigate to the desired location using the Save Experiment dialog box.
  - Default save location, select **Tools > Preferences**, then select the **General** tab (default). In the Default Data Folder field, browse to the desired location.

For more information on using Advanced Setup, see “Advanced Setup Workflow” on page 110.
Prepare the Reactions

This chapter covers:

- Chapter Overview ................................................................. 42
- Prepare the Template ............................................................ 43
- Prepare the Samples ............................................................... 44
- Prepare the Reaction Mix ......................................................... 46
- Prepare the Reactions ............................................................. 48

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by pressing F1, clicking 📚 in the toolbar, or selecting Help ▶ StepOne Software Help.
Chapter Overview

This chapter explains how to prepare the PCR reactions for the presence/absence example experiment and provides guidelines for how to prepare the PCR reactions for your own presence/absence experiment.

Example Experiment Workflow

The workflow for preparing the PCR reactions for the example experiment provided with this getting started guide is shown below:

Start Experiment

\[ \downarrow \]

Design the Experiment (Chapter 2)

\[ \downarrow \]

Prepare the Reactions (Chapter 3)

1. Prepare the template.
2. Prepare the samples.
3. Prepare the reaction mix.
4. Prepare the reactions.

\[ \downarrow \]

Run the Experiment (Chapter 4)

\[ \downarrow \]

Analyze the Experiment (Chapter 5)

End Experiment
Prepare the Template

In this section, prepare the DNA template for the PCR reactions using the PrepMan® Ultra Sample Preparation Reagent kit.

About the Example Experiment
For the presence/absence example experiment, the template for the PCR reactions is DNA extracted from bacteria found in ground beef. There are 5 samples of ground beef to analyze for the presence or absence of a pathogen.

Required Materials
- DNA isolated from blood, tissue culture cells and buccal swabs.
- DNA isolated from animal or plant tissue.
- Purified plasmid DNA.
- One of the products listed below for DNA isolation:

<table>
<thead>
<tr>
<th>Kit‡</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>PrepMan® Ultra Sample Preparation Reagent kit</td>
<td>4322547</td>
</tr>
<tr>
<td>NucPrep® DNA Chemistry for Tissues</td>
<td>4340274</td>
</tr>
<tr>
<td>BloodPrep® Chemistry for Blood, Tissue Culture Cells, and Buccal Swabs</td>
<td>4346860</td>
</tr>
<tr>
<td>Plasmid Miniprep Kit</td>
<td>402790</td>
</tr>
</tbody>
</table>

‡ Applied Biosystems recommends using the kits with the ABI Prism® 6100 Nucleic Acid PrepStation or the ABI Prism® 6700 Nucleic Acid Automated Workstation.

Prepare the Template
Use the DNA isolation kits recommended in the table above, or follow your own protocol to isolate DNA.

Preparation Guidelines
When you prepare your own presence/absence experiment, extract DNA from the tissue or sample. Ensure that the DNA you use:
- Has a $A_{260/280}$ ratio of greater than 1.7.
- Has a stock concentration of 100 ng/µL.
- Is extracted from the raw material you are testing using an optimized protocol.
- Does not contain PCR inhibitors.
- Is intact as visualized by gel electrophoresis.
- Has not been heated above 60 °C.
For More Information

Applied Biosystems supplies several chemistries for isolating DNA from blood, tissue, cell cultures, plant material, and food. For more information refer to:

- DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs Protocol
- NucPrep® Chemistry Isolation of Genomic DNA from Animal and Plant Tissue Protocol
- PrepMan® Ultra Sample Preparation Reagent Protocol

Prepare the Samples

In this section, dilute the DNA samples using the volumes that were calculated by the StepOne™ software.

About the Example Experiment

For the presence/absence example experiment, 2 µL of 50 ng/µL sample DNA is added to 18 µL of Reaction Mix. The final reaction volume per well is 20 µL. For all wells containing sample DNA, the final concentration of DNA per well is 5 ng/µL, and the total amount of DNA per well is 100 ng.

For the presence/absence example experiment:

- The stock concentration of sample (Unknown) DNA, after preparing the template, is 100 ng/µL.
- The desired concentration of sample (Unknown) DNA to add to the reaction is 50 ng/µL.
- The reaction volume per well is 20 µL.
- The excess reaction volume is 10%.
- The volumes calculated in the software are:

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Stock Concentration (ng/µL)</th>
<th>Sample Volume (µL)</th>
<th>Diluent Volume (µL)</th>
<th>Total Volume of Diluted Sample (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown 1</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>Unknown 2</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>Unknown 3</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>Unknown 4</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
<tr>
<td>Unknown 5</td>
<td>100</td>
<td>9.0</td>
<td>9.0</td>
<td>18.0</td>
</tr>
</tbody>
</table>

Required Materials

- Buffer or water to dilute the sample
- Microcentrifuge tubes
- Pipettors
- Pipette tips
- Sample stock
- Vortexer

Notes
Prepare the Samples

1. Label a separate microcentrifuge tube for each unknown sample:
   - Unknown 1
   - Unknown 2
   - Unknown 3
   - Unknown 4
   - Unknown 5

2. Add the required volume of water to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample Name</th>
<th>Diluent Volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unknown 1</td>
<td>9.0</td>
</tr>
<tr>
<td>2</td>
<td>Unknown 2</td>
<td>9.0</td>
</tr>
<tr>
<td>3</td>
<td>Unknown 3</td>
<td>9.0</td>
</tr>
<tr>
<td>4</td>
<td>Unknown 4</td>
<td>9.0</td>
</tr>
<tr>
<td>5</td>
<td>Unknown 5</td>
<td>9.0</td>
</tr>
</tbody>
</table>

3. Add the required volume of sample stock to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample Name</th>
<th>Sample Volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unknown 1</td>
<td>9.0</td>
</tr>
<tr>
<td>2</td>
<td>Unknown 2</td>
<td>9.0</td>
</tr>
<tr>
<td>3</td>
<td>Unknown 3</td>
<td>9.0</td>
</tr>
<tr>
<td>4</td>
<td>Unknown 4</td>
<td>9.0</td>
</tr>
<tr>
<td>5</td>
<td>Unknown 5</td>
<td>9.0</td>
</tr>
</tbody>
</table>

4. Vortex each sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reactions.

• Centrifuge

Notes
Prepare the Reaction Mix

Prepare the reaction mix using the components and volumes that were calculated by the StepOne software (“Complete the Reaction Mix Calculations Tab” on page 31).

**Note:** The reaction mix includes all components except sample or negative control (buffer or IPC blocking agent).

### About the Example Experiment

All samples contain a primer and probe set for the IPC and a primer and probe set for the pathogen, therefore, only one reaction mix is required.

The reaction mix components and volumes calculated in the software are:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (µL) for 1 Reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Universal PCR Master Mix (2.0×) or TaqMan® Universal PCR Master Mix, No Amplerase® UNG</td>
<td>10.00</td>
</tr>
<tr>
<td>10× IPC Mix</td>
<td>2.00</td>
</tr>
<tr>
<td>50× IPC DNA</td>
<td>0.40</td>
</tr>
<tr>
<td>20× pathogen mix</td>
<td>1.00</td>
</tr>
<tr>
<td>Water/Buffer</td>
<td>4.60</td>
</tr>
<tr>
<td><strong>Total Reaction Mix Volume</strong></td>
<td><strong>18.00</strong></td>
</tr>
</tbody>
</table>

**Note:** The sample is not added at this time.

### Required Materials

- Microcentrifuge tubes
- Pipettors
- Pipette tips
- Reaction mix components (listed above)
- Centrifuge

**CAUTION** CHEMICAL HAZARD. TaqMan Universal PCR Master Mix may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

**CAUTION** CHEMICAL HAZARD. TaqMan 2X Universal PCR Master Mix, No AmpErase UNG may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

---

**Notes**
1. Label an appropriately sized tube for the reaction mix: **Pathogen Reaction Mix**.

2. Add the required volumes of each component to the tube:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (µL) for 1 Reaction</th>
<th>Volume for 48 Reactions (Including Excess) (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Universal PCR Master Mix (2.0X)</td>
<td>10.00</td>
<td>528.0</td>
</tr>
<tr>
<td>10X IPC Mix</td>
<td>2.00</td>
<td>105.6</td>
</tr>
<tr>
<td>50X IPC DNA</td>
<td>0.40</td>
<td>21.1</td>
</tr>
<tr>
<td>20X pathogen mix</td>
<td>1.00</td>
<td>52.8</td>
</tr>
<tr>
<td>Water/Buffer</td>
<td>4.60</td>
<td>242.9</td>
</tr>
<tr>
<td><strong>Total Reaction Mix Volume</strong></td>
<td><strong>18.00</strong></td>
<td><strong>950.4</strong></td>
</tr>
</tbody>
</table>

3. Mix the reaction mix by gently pipetting up and down, then cap the tube.

4. Centrifuge the tube briefly.

5. Place the reaction mix on ice until you prepare the reactions.

---

**Preparation Guidelines**

When you prepare your own presence/absence reactions:

- Prepare the reaction mix for each target separately.
- Include excess volume in your calculations to provide excess volume for the loss that occurs during reagent transfers.
- Include all required components.
- Prepare the reagents according to the manufacturer’s instructions.
- Keep the TaqMan probe protected from light, in the freezer, until you are ready to use it. Excessive exposure to light may affect the fluorescent probes.
- Prior to use:
  - Mix the master mix thoroughly by swirling the bottle.
  - Resuspend the assay mix by vortexing, then centrifuge the tube briefly.
  - Thaw any frozen samples by placing them on ice. When thawed, resuspend the samples by vortexing, then centrifuge the tubes briefly.
Prepare the Reactions

Prepare the reactions using the volumes that were calculated by the StepOne software. See “Review the Reaction Setup” on page 31.

For the presence/absence experiment:

- A MicroAmp™ Optical 48-Well Reaction Plate is used.
- The final concentration of DNA for all of the samples is 5 ng/µL.
- The reaction volume is 20 µL/well.
- The reaction plate contains:
  - 4 Negative Control-Blocked IPC
  - 4 Negative Control-IPC
  - 40 Unknown-IPC
  - 0 Empty
- The plate layout automatically generated by the StepOne software is used:

![Plate Layout Image]

**Note:** The example experiment was created for a StepOne instrument. If you selected the StepOnePlus instrument in the Experiment Properties screen (page 20), your reaction plate layout will differ from the layout shown above. The software displays a 96-well reaction plate layout for the StepOnePlus instrument. For an example of the 96-well reaction plate layout, see page 11.

---

**Notes**
Prepare the Reactions

Use the plate layout and instructions to prepare the PCR reactions. Make sure the arrangement of PCR reactions matches the plate layout in the software:

1. Add 18 µL of reaction mix to the appropriate wells.

<table>
<thead>
<tr>
<th>Reaction Mix</th>
<th>Add 18 µL Reaction Mix to Wells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pathogen</td>
<td>A1, A2, A3, A4, A5, A6, A7, A8, B1, B2, B3, B4, B5, B6, B7, B8, C1, C2, C3, C4, C5, C6, C7, C8, D1, D2, D3, D4, D5, D6, D7, D8, E1, E2, E3, E4, E5, E6, E7, E8, F1, F2, F3, F4, F5, F6, F7, F8</td>
</tr>
</tbody>
</table>

2. Prepare Negative Control-IPC reactions (Task = NC-IPC): Add 2 µL of buffer or water to the appropriate wells.

<table>
<thead>
<tr>
<th>Add 2 µL Buffer or Water to Wells</th>
</tr>
</thead>
<tbody>
<tr>
<td>A5, A6, A7, A8</td>
</tr>
</tbody>
</table>

3. Prepare Negative Control-Blocked IPC reactions (Task = NC-Blocked IPC): Add 2 µL of IPC blocking agent to the appropriate wells.

<table>
<thead>
<tr>
<th>Add 2 µL Blocking Agent to Wells</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1, A2, A3, A4</td>
</tr>
</tbody>
</table>

4. Prepare unknown reactions (Task = Unknown): Add 2 µL of sample to the appropriate wells.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Add 2 µL Sample to Wells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown 1</td>
<td>B1, B2, B3, B4, B5, B6, B7, B8</td>
</tr>
<tr>
<td>Unknown 2</td>
<td>C1, C2, C3, C4, C5, C6, C7, C8</td>
</tr>
<tr>
<td>Unknown 3</td>
<td>D1, D2, D3, D4, D5, D6, D7, D8</td>
</tr>
<tr>
<td>Unknown 4</td>
<td>E1, E2, E3, E4, E5, E6, E7, E8</td>
</tr>
<tr>
<td>Unknown 5</td>
<td>F1, F2, F3, F4, F5, F6, F7, F8</td>
</tr>
</tbody>
</table>

Notes
5. Cover the reactions according to the plastic consumables you are using:
   - Optical reaction plate: Seal the reaction plate with optical adhesive film.
   - Tube strips: Cover the tubes with caps.

6. Centrifuge the tubes briefly to remove air bubbles.

7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.

**IMPORTANT!** Do not allow the bottom of the reaction plate to become dirty. Fluids and other contaminants that adhere to the bottom of the reaction plate can contaminate the sample block(s) and cause an abnormally high background signal.

8. Until you are ready to perform the run, place the reaction plate on ice in the dark.

### Preparation Guidelines

When you prepare your own presence/absence experiment:
- Wear appropriate protective eyewear, clothing, and gloves.
- Make sure you use the appropriate consumables.
- Make sure the arrangement of the PCR reactions matches the plate layout in the StepOne software. You can either:
  - Accept the plate layout automatically generated by the StepOne software.
  - Use Advanced Setup to change the plate layout in the software.
- If you use optical adhesive film to seal your reaction plates, seal each reaction plate as follows:

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Correct" /></td>
<td><img src="image2" alt="Incorrect" /></td>
</tr>
</tbody>
</table>

**Liquid is at the bottom of the well.**
- Not centrifuged with enough force, or
- Not centrifuged for enough time

---

**Notes**

---

1. Place the reaction plate onto the center of the 96-well base. Be sure the reaction plate is flush with the top surface of the 96-well base.

2. Load the reaction plate as desired.
### Chapter 3 Prepare the Reactions

#### Prepare the Reactions

<table>
<thead>
<tr>
<th>Action</th>
<th>Example</th>
</tr>
</thead>
</table>
| 3. Remove a single optical adhesive film (film) from the box.  
- *For the StepOne system reaction plate*, bend both end-tabs upward. Hold the film backing side up.  
- *For the StepOnePlus system reaction plate*, fold back one of the end-tabs. Hold the film backing side up. | ![StepOne™ System](image1) ![StepOnePlus™ System](image2) |
| 4. In one swift movement, peel back the white protective backing from the center sealing surface. Do not touch the center sealing surface. **IMPORTANT!** Improper peeling of the optical adhesive film may result in haziness, but will not affect results. Haziness will disappear when the film comes into contact with the heated cover in the instrument. | ![StepOne™ System](image3) ![StepOnePlus™ System](image4) |
| 5. Holding the film by the end-tabs, lower the film onto the reaction plate (adhesive side facing the reaction plate). Be sure the film is completely covering all wells of the reaction plate. | ![StepOne™ System](image5) ![StepOnePlus™ System](image6) |
| 6. While applying firm pressure, move the applicator slowly across the film, horizontally and vertically, to ensure good contact between the film and the entire surface of the reaction plate. | ![StepOne™ System](image7) ![StepOnePlus™ System](image8) |
| 7. While using the applicator to hold the edge of the film in place, grasp one end of the end-tab and pull up and away sharply. Repeat for the other end-tab. | ![StepOne™ System](image9) ![StepOnePlus™ System](image10) |
| 8. To ensure a tight, evaporation-free seal:  
  a. Repeat step 6.  
  b. While applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film. **Note:** Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight, evaporation-free seal. | ![StepOne™ System](image11) ![StepOnePlus™ System](image12) |
| 9. Inspect the reaction plate to be sure all wells are sealed. You should see an imprint of all wells on the surface of the film. | ![StepOne™ System](image13) ![StepOnePlus™ System](image14) |

**For More Information**

For more information on:
- Consumables, see “Supported Consumables” on page 4.
- Using Advanced Setup to change the plate layout, see “Advanced Setup Workflow” on page 110.

**Notes**

---

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Presence/Absence Experiments 51
Run the Experiment

This chapter covers:
- Chapter Overview ................................................................. 54
- Prepare for the Run ............................................................... 55
- (Optional) Enable the Notification Settings ............................... 57
- Start the Run ........................................................................ 59
- Monitor the Run ..................................................................... 63
- Unload the Instrument and Transfer the Data .............................. 70

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by pressing F1, clicking in the toolbar, or selecting Help → StepOne Software Help.
Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems.

**Example Experiment Workflow**

The workflow for running the example experiment provided with this getting started guide is shown below.

```
Start Experiment
▼
Design the Experiment (Chapter 2)
▼
Prepare the Experiment (Chapter 3)
▼
Run the Experiment (Chapter 4)
  1. Prepare for the run.
  2. (Optional) Enable the notification settings.
  3. Start the run.
  4. Monitor the run.
  5. Unload the instrument and transfer the data.
▼
Analyze the Experiment (Chapter 5)
▼
End Experiment
```
Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 2, then loading the sealed reaction plate into the StepOne™ or StepOnePlus™ instrument.

Open the Example Experiment

1. Double-click (StepOne software shortcut) or select
   Start > All Programs > Applied Biosystems > StepOne Software
   <software name>
   where <software name> is the current version of the StepOne software.

2. From the Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder (default):
   <drive>:\Applied Biosystems\<software name>\experiments

4. Double-click Presence Absence Example to open the example experiment file you created in Chapter 2.
Load the Reaction Plate Into the Instrument

**CAUTION** PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100 °C. If the instrument has been used recently, keep your hands away until the sample block(s) reach room temperature.

**IMPORTANT!** Wear powder-free gloves when you handle the reaction plate.

1. Open the instrument drawer.

   ![StepOne instrument sample block](image1)

   ![StepOnePlus instrument VeriFlex™ Sample Blocks](image2)

2. Place the reactions in the sample block(s):
   - If using a reaction plate: Place the reaction plate in the sample block(s) with well A1 at the back-left corner.
   - If using reaction tube strips: Place the tray containing the tube strips in the sample block(s).
   - If using reaction tubes: Place the tray containing the tubes in the sample block(s).
Chapter 4 Run the Experiment
(Optional) Enable the Notification Settings

IMPORTANT! For optimal performance with partial loads:

**StepOnePlus instruments** - Load at least 16 tubes and arrange them in:
- Adjacent columns of 8 tubes, using rows A through H. For example, fill wells in column 1 (rows A through H) and column 2 (rows A through H).
  
  or

- Adjacent rows of 8 tubes, using columns 3 through 10. For example, fill wells in row A (columns 3 through 10) and row B (columns 3 through 10).

**StepOne instruments** - Load at least 4 tubes in the sample block.

3. Close the instrument drawer carefully.

(Optional) Enable the Notification Settings

Enable the notification settings so that the StepOne software alerts you via email when the StepOne or StepOnePlus instrument begins and completes the run, or if an error occurs during the run. Enabling the notifications settings feature is optional and does not affect the performance of the StepOne™ and StepOnePlus™ systems or the duration of the run.

IMPORTANT! The notification settings feature is available only if the computer that you are using is running the StepOne or StepOnePlus instrument and is connected to an Ethernet network.

**Note:** The notification system is also available to computers that are monitoring a StepOne or StepOnePlus instrument remotely. For more information, see “Remote Monitor” on page 67.

About the Example Experiment

In the example experiment:
- The StepOne software is set up to send notifications to three users (scientist, supervisor, and technician at mycompany.com) when the StepOne or StepOnePlus system ends the run and if it encounters any errors during operation.
- The example SMTP server (www.mycompany.com) is set up for Secure Sockets Layer (SSL) encryption and requires authentication for use.
### Set Up the Notification Settings

1. In the StepOne software, click Run in the navigation pane.
2. Click Notification Settings.
3. Select Yes for Enable Notifications.
4. Select the events that will trigger notifications:
   - b. Select Run Completed.
5. In the Enter e-mail addresses for notifications field, enter: scientist@mycompany.com, supervisor@mycompany.com, technician@mycompany.com.
6. In the Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.
7. Set the authentication settings:
   - a. Select Yes for Server requires authentication.
   - b. In the User Name field, enter Example User.
   - c. In the Password field, enter password.

### Run Guidelines

When you set up the StepOne or StepOnePlus system for automatic notification:

- Your system must be set up for network use. Refer to the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide*.
- Select the events for which you want to receive e-mail notifications:
  - **Instrument Error** – When selected, recipients are e-mailed all errors encountered by the instrument during each run.
  - **Run Started** – When selected, recipients are e-mailed every time the instrument starts a run.
Run Completed – When selected, recipients are e-mailed every time the
instrument completes a run.

- Obtain e-mail addresses to receive notifications.

**IMPORTANT!** Separate addresses with a comma (,).

- Contact your systems administrator or information technology department if you
  need:
  - E-mail addresses for users who will receive notifications
  - A network address for a simple mail transfer protocol (SMTP) server on the LAN
  - A user name and password for the server, if required for access
  - The Secure Sockets Layer (SSL) setting of the server (on or off)

## Start the Run

Start the run according to the layout of your StepOne or StepOnePlus system:

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colocated</td>
<td>The yellow cable connects the computer to the instrument</td>
<td>“Colocated Startup” below</td>
</tr>
<tr>
<td>Standalone</td>
<td>• The computer and the instrument are not connected, or</td>
<td>“Standalone Startup” on page 60</td>
</tr>
<tr>
<td></td>
<td>• The computer and the instrument are connected to the same network.</td>
<td></td>
</tr>
</tbody>
</table>

**Colocated Startup**

Perform this procedure if your computer is directly connected to your StepOne or
StepOnePlus instrument by the yellow cable.

1. In the StepOne software, click Run in the navigation pane.

2. Click START RUN.

---

Notes

---

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Presence/Absence Experiments
Perform these procedures if your computer and StepOne or StepOnePlus instrument are not directly connected by the yellow cable. Start with:

- “Send the Experiment to the Instrument Over the Network” on page 60 if your computer and instrument are connected to the same network.

or

- “Transfer the Experiment to the Instrument Using a USB Drive” on page 60 if your computer and instrument are not connected to the same network.

Send the Experiment to the Instrument Over the Network

1. In the StepOne software, click Send Experiment to Instrument.

2. In the Send Experiment to Instrument dialog box:
   a. Click Browse, navigate to the example experiment file, then click Open.
   b. Select the instrument to receive the experiment file.
   c. Click Send Experiment to send the experiment to your instrument over the network.

   Note: If your instrument is not listed, set up the instrument for monitoring as explained in the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide.

3. When prompted, click OK to close the confirmation.


Transfer the Experiment to the Instrument Using a USB Drive

1. Connect the USB drive to one of the USB ports on the computer.

2. In the StepOne software, select Save, then click Save As.

3. In the Save dialog box, navigate to the USB drive, then click Save.
4. Remove the USB drive from your computer, then connect it to the USB port of your StepOne or StepOnePlus instrument.

![USB Drive](image1)

![StepOne Plus Instrument](image2)

5. Go to “Start the Instrument Run Using the Touchscreen” below.

Start the Instrument Run Using the Touchscreen

1. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

   **Note:** If the touchscreen is not at the Main Menu screen, touch 🔒.

2. Wait for the USB sign to appear on the touchscreen.

3. In the Main Menu screen, touch **Browse/New Experiments**.

4. In the Browse screen, touch 🍂 **Folders**.

5. In the Choose an Experiment Folder screen:
   - Touch **USB** if you transferred the experiment on a USB drive.
   - Touch **Default** if you sent the experiment over a network connection.

6. Before starting the run, save the example experiment to your instrument:
   a. In the Browse screen, touch the example experiment name, then touch **Copy**.
   b. In the Save Experiment screen, navigate to a destination folder, then click **Save & Exit**.

7. In the Browse screen, touch the example experiment name, then touch 🎉 **Start Run**.
8. In the Run Parameters screen:
   a. Touch the **Reaction Volume** field, use the keypad to enter the reaction volume for the example experiment, then touch **Done**.
   b. Touch **Start Run Now**.
Chapter 4 Run the Experiment

Monitor the Run

Monitor the run according to the layout of your StepOne or StepOnePlus system:

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colocated</td>
<td>The yellow cable connects the computer to the instrument.</td>
<td>“Colocated Monitoring” below</td>
</tr>
<tr>
<td>Standalone (Networked)</td>
<td>The computer and the instrument are connected to the same network.</td>
<td>“Remote Monitor” on page 67</td>
</tr>
<tr>
<td>Standalone (Basic)</td>
<td>The computer and the instrument are not connected.</td>
<td>“Standalone Monitoring” on page 69</td>
</tr>
</tbody>
</table>

Colocated Monitoring

If your computer is directly connected to your StepOne or StepOnePlus instrument by the yellow cable, you can view the progress of the run in realtime as described below. During the run, periodically view all three plots available from the StepOne software for potential problems.

<table>
<thead>
<tr>
<th>#</th>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Stop the run</td>
<td>1. In the StepOne software, click STOP RUN.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. In the Stop Run dialog, click one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Stop Immediately to stop the run immediately.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Stop after Current Cycle/Hold to stop the run after the current cycle or hold.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Cancel to continue the run.</td>
</tr>
<tr>
<td>B</td>
<td>View amplification data in realtime</td>
<td>Select [ Amplification Plot.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About the Amplification Plot Screen” on page 64.</td>
</tr>
<tr>
<td>C</td>
<td>View temperature data for the run in realtime</td>
<td>Select [ Temperature Plot.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About the Temperature Plot Screen” on page 65.</td>
</tr>
<tr>
<td>D</td>
<td>View progress of the run in the Run Method screen</td>
<td>Select [ Run Method.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About the Run Method Screen” on page 66.</td>
</tr>
<tr>
<td>E</td>
<td>Enable/disable the Notification Settings</td>
<td>Select or deselect Enable Notifications.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “(Optional) Enable the Notification Settings” on page 57.</td>
</tr>
</tbody>
</table>
Chapter 4 Run the Experiment
Monitor the Run

About the Amplification Plot Screen

The Amplification Plot screen allows you to view sample amplification as your instrument collects fluorescence data during a run. If a method is set up to collect real-time data, the Amplification Plot screen displays the data for the wells selected in the View Plate Layout tab. The plot contrasts normalized dye fluorescence (ΔRn) and cycle number. The figure below shows the Amplification Plot screen as it appears during the example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in the View Plate Layout tab.

The Amplification Plot screen is useful for identifying and examining abnormal amplification. Abnormal amplification can include the following:

- Increased fluorescence in negative control wells.
• Absence of detectable fluorescence at an expected cycle (determined from previous similar experiments run using the same reagents under the same conditions).

If you notice abnormal amplification or a complete absence of signal, troubleshoot the error as explained in the StepOne Software Help (click 🔄 or press F1).

**About the Temperature Plot Screen**

During a run, the Temperature Plot screen displays the temperatures of the sample block(s), the heated cover, and samples (calculated) in realtime. The figure below shows the Temperature Plot screen as it appears during the example experiment.

<table>
<thead>
<tr>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Add/remove temperature plots</td>
<td>Select <strong>Cover</strong> or <strong>Sample Block</strong> to toggle the presence of the associated data in the plot.</td>
</tr>
<tr>
<td>B Change the time displayed by plot</td>
<td>From the <strong>View</strong> dropdown menu, select the amount of time to display in the plot.</td>
</tr>
</tbody>
</table>
| C Display a fixed time window during the instrument run | Select **Fixed View**.  
If the entire plot does not fit in the screen, the screen is not updated as the run progresses. For example, if you select 10 minutes from the View dropdown menu, the plot will show data for 10 minutes. If the run lasts more than 10 minutes:  
• The plot updates as the run progresses with Fixed View deselected.  
• The plot does not update as the run progresses with Fixed View selected. |

The Temperature Plot screen can be useful for identifying hardware failures. When monitoring the Temperature Plot screen, observe the Sample and Block plots for abnormal behavior.
• In general, the Sample and Block plots should mirror each other approximately. A significant deviation of the plots may indicate a problem.

• The Cover plot should maintain the constant temperature specified in the method. A departure from the constant temperature may indicate a problem.

If you notice an abnormal temperature plot, troubleshoot the error as explained in the StepOne Software Help (click 🛠️ or press F1).

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.

---

**About the Run Method Screen**

The Run Method screen displays the run method selected for the run in progress. The software updates the Run Status field throughout the run. The figure below shows the Run Method screen as it appears in the example experiment.

<table>
<thead>
<tr>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Change the number of cycles</td>
</tr>
<tr>
<td>B</td>
<td>Add a melt curve stage to the end of the run</td>
</tr>
<tr>
<td>C</td>
<td>Add a Hold stage to the end of the run</td>
</tr>
<tr>
<td>D</td>
<td>Apply your changes</td>
</tr>
</tbody>
</table>

If an alert appears, click the error for more information and troubleshoot the problem as explained in the StepOne Software Help (click 🛠️ or press F1).
Remote Monitor

If your StepOne or StepOnePlus instrument is connected to a network, you can use the Remote Monitor in the StepOne software to view the progress of the run in realtime from any computer on the network.

**IMPORTANT!** Networked computers cannot control the StepOne or StepOnePlus instrument, only monitor it.

To monitor your instrument remotely:

1. In the StepOne software, select **Instrument ▶ Remote Monitor**.
2. In the navigation pane, select your instrument.
   
   If the navigation pane does not list your instrument:
   
   a. Click **Add Instrument**.
   
   b. Enter a name for the instrument profile within the Remote Monitor.

   **Note:** Enter any name that helps you identify the instrument. The profile name you enter will be displayed in the Remote Monitor and in the instrument dropdown menus when you send experiments, download experiments, or monitor instruments.

   c. In the Instrument Name, Host Name, or IP Address field:
      
      • If you know the host name, enter the host name.
      
      • If you do not know the host name, enter the instrument name or IP address.

   **Note:** The instrument name and IP address are displayed on the instrument touchscreen. Go to **Settings Menu ▶ Admin Menu ▶ Set Instrument Name** or **Set IP Address**. Contact your systems administrator or information technology department for the host name.

   d. Click **Save & Exit**.

**Note:** For more information on configuring the StepOne or StepOnePlus instrument for network use or for the Remote Monitor feature, refer to the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide*.
3. Click Start monitoring the instrument for your instrument. It may take several minutes for the instrument to send the information to your computer.

4. View data as described below.

<table>
<thead>
<tr>
<th>#</th>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
</table>
| A | View amplification data in realtime | Click Amplification Plot.  
See “About the Amplification Plot Screen” on page 64. |
| B | View temperature data for the run in realtime | Click Temperature Plot.  
See “About the Temperature Plot Screen” on page 65. |
| C | View progress of the run in the Run Method screen | Click Run Method.  
See “About the Run Method Screen” on page 66. |
| D | Enable/disable the Notification Settings | Select or deselect Enable Notifications.  
See “(Optional) Enable the Notification Settings” on page 57. |
Standalone Monitoring

If you started the run from your StepOne or StepOnePlus instrument, you can view the progress of the run from the touchscreen. The Run Method screen displays the method for the experiment and highlights the thermal profile steps as the instrument performs them.

<table>
<thead>
<tr>
<th>#</th>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Add a melt curve stage to the run</td>
<td>Touch [ Add Melt Curve, then touch [ OK.</td>
</tr>
<tr>
<td>B</td>
<td>Display the time remaining in the run</td>
<td>Touch [ Display Experiment Time, then touch [ to return to the Run Method screen.</td>
</tr>
<tr>
<td>C</td>
<td>Stop the run</td>
<td>Touch [ STOP, then touch:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [ Stop to stop the run after the instrument completes the current cycle or hold.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [ Abort to stop the run immediately.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [ to continue the run with no changes.</td>
</tr>
<tr>
<td>D</td>
<td>View experiment information</td>
<td>Touch [ View Experiment Information, then touch [ to return to the Run Method screen.</td>
</tr>
<tr>
<td>E</td>
<td>View the Error Log</td>
<td>Touch the status bar to display the error log.</td>
</tr>
</tbody>
</table>

Notes
Unload the Instrument and Transfer the Data

When your StepOne or StepOnePlus instrument displays the Main Menu screen, unload the reaction plate from the instrument and transfer the experiment data to the computer for analysis.

⚠️ CAUTION PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100 °C. Keep your hands away until the sample block(s) reach room temperature.

Note: When the StepOne or StepOnePlus instrument completes a run, the system saves the details of the run to the run history, which remains present in the system until the instrument completes another run.

1. When the Run Report screen appears in the StepOne or StepOnePlus instrument touchscreen, touch 📊.
2. Open the instrument drawer.
3. Remove the reaction plate from the sample block(s).
4. Carefully close the instrument drawer.

Select a Data Transfer Method

Transfer the experiment to your computer for analysis according to the layout of your StepOne or StepOnePlus system:

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colocated</td>
<td>The yellow cable connects the computer and the instrument.</td>
<td>“Colocated Data Transfer” below</td>
</tr>
<tr>
<td>Standalone (Networked)</td>
<td>The computer and the instrument are connected to the same network.</td>
<td>“Remote Data Transfer” on page 71</td>
</tr>
<tr>
<td>Standalone (Basic)</td>
<td>The computer and the instrument are not connected.</td>
<td>“Standalone Data Transfer” on page 72</td>
</tr>
</tbody>
</table>

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Presence/Absence Experiments
Chapter 4 Run the Experiment
Unload the Instrument and Transfer the Data

Colocated Data Transfer

If your computer is directly connected to your StepOne or StepOnePlus instrument by the yellow cable, no action is necessary. The StepOne software automatically transfers the experiment data from the instrument to the computer after the run.

**Note:** In a colocated layout, you can start the run from the computer or from the instrument touchscreen. However, the StepOne software only transfers the experiment data automatically when a run is started from the computer (see “Colocated Startup” on page 59).

Remote Data Transfer

If your computer and StepOne or StepOnePlus instrument are connected to the same Ethernet network, download the experiment from the instrument over the network:

1. In the StepOne software, click **Download Experiment from Instrument** to open the Download Experiment from Instrument dialog box.
2. From the Select Instrument dropdown menu, select your instrument.
3. From the Experiment dropdown menu, select the example experiment file.
4. In the Download File To field:
   a. Click **Browse**.
   b. Navigate to:
      
      \( <\text{drive}>\backslash\text{Applied Biosystems}\backslash<\text{software name}>\backslash\text{experiments} \)
      
      where:
      
      - \( <\text{drive}> \) is the computer hard drive on which the StepOne software is installed. The default installation drive for the software is the D drive.
      - \( <\text{software name}> \) is the current version of the StepOne software.
   c. Click **Select**.
5. Click **Download Experiment** to download the example experiment file from your instrument to your computer over the network.

6. When prompted, click **OK** to close the confirmation.

Notes
Standalone Data Transfer

If your computer is not connected to your StepOne or StepOnePlus instrument, use the USB drive to transfer the experiment from the instrument to the computer:

1. If not already connected to the instrument, connect a USB drive to the USB port.

2. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

   **Note:** If the touchscreen is not at the Main Menu screen, touch 🍃.

3. Wait for the USB sign to appear on the touchscreen.

4. In the Main Menu, touch **Collect Results** to save the data to the USB drive.

   **Note:** If your instrument cannot find the USB drive, remove the USB drive, then try again. If the instrument still does not recognize the USB drive, try another USB drive.

5. When prompted that the data has been transferred successfully, touch **OK**.

6. Remove the USB drive from your instrument, then connect it to one of the USB ports on your computer.

7. In the computer desktop, use the Windows explorer open the USB drive.
8. Copy the example experiment file to:

<drive>:\Applied Biosystems\<software name>\experiments\n
where:

- <drive> is the computer hard drive on which the StepOne software is installed. The default installation drive for the software is the D drive.
- <software name> is the current version of the StepOne software.
Chapter 5

Analyze the Experiment

This chapter covers:

- Chapter Overview ................................................................. 76
- Section 5.1  Review Results. ..................................................... 77
- Section 5.2  Troubleshoot (If Needed). ..................................... 97

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by pressing F1, clicking 🎨 in the toolbar, or selecting Help  StepOne Software Help.
Chapter Overview

The StepOne™ software analyzes your data using the endpoint method. Section 1 of this chapter explains how to review the analyzed data using several of the analysis screens and how to publish data. If you receive questionable results, Section 2 of this chapter explains how to perform some troubleshooting steps.

Example Experiment Workflow

The workflow for analyzing the example experiment provided with this getting started guide is shown below.

Start Experiment

Design the Experiment (Chapter 2)

Prepare the Reactions (Chapter 3)

Run the Experiment (Chapter 4)

Analyze the Experiment (Chapter 5)

Section 1, Review Results:
1. Analyze the experiment.
2. View the presence/absence plot.
3. View the amplification plot.
4. View the results in a table.
5. Publish the Data.

Section 2, Troubleshoot (If Needed):
1. View the analysis settings.
2. View the quality summary.
3. Omit wells.
4. View the multicomponent plot.
5. View the raw data plot.

End Experiment
Section 5.1 Review Results

This section covers:
- Analyze the Experiment ................................................................. 78
- View the Presence/Absence Plot ......................................................... 84
- View the Amplification Plot ............................................................... 86
- View the Well Table ........................................................................... 93
- Publish the Data ................................................................................ 96
Analyze the Experiment

The StepOne software analyzes the experiment and displays results in the analysis screens (for example, the Amplification Plot screen or the QC Summary screen).

About the Example Experiment

For the presence/absence experiment, use the data file that installs with the StepOne software. The data file was created with the same design parameters provided in Chapter 2, then run and analyzed on a StepOne system.

You can find the data file for the example experiment on your computer:

`<drive>:\Applied Biosystems\<software name>\experiments\examples\Presence Absence Example.eds`

where:

- `<drive>` is the computer hard drive on which the StepOne software is installed. The default installation drive for the software is the D drive.
- `<software name>` is the current version of the StepOne software.

Analyze the Example Experiment

1. Double-click (StepOne software shortcut) or select
   `Start ▶ All Programs ▶ Applied Biosystems ▶ StepOne Software ▶ <software name>`
   where `<software name>` is the current version of the StepOne software.

2. From the Home screen, click **Open**.

3. In the Open dialog box, double-click the **examples** folder:
   `<drive>:\Applied Biosystems\<software name>\experiments\examples`

4. Double-click **Presence/Absence Example** to open the example experiment data file.

**Note:** The examples folder contains several data files; be sure to select **Presence Absence Example**. For information on the other data files, see “Data Files in the Examples Folder” on page 12.
5. In the Experiment Menu pane, click **Analyze**. The StepOne software analyzes the data using the default analysis settings.

Guidelines

When you analyze your own presence/absence experiment immediately after a run, the StepOne software automatically analyzes the data using the default analysis settings, then displays the Presence/Absence Plot on your computer. To reanalyze the data, click **Analyze**.

See “Software Elements” below and “Navigation Tips” on page 82 for information on navigating within the analysis screens.
Software Elements

The StepOne software elements for the analysis screens are illustrated below.

1. **Menu bar** – Displays the menus available in the software:
   - File
   - Edit
   - Instrument
   - Analysis
   - Tools
   - Help

2. **Toolbar** – Displays the tools available in the software:
   - New Experiment
   - Open
   - Save
   - Close
   - Send Experiment to Instrument
   - Download Experiment from Instrument
   - Export
   - Print Report

3. **Experiment header** - Displays the experiment name, experiment type, and reagents for the open experiment.

4. **Experiment Menu pane** – Provides links to the following software screens:
   - Setup screens
   - Run screens
   - Analysis screens:
     - Presence/Absence Plot
     - Amplification Plot (if the experiment includes amplification)
     - Multicomponent Plot
     - Raw Data Plot
     - QC Summary
     - Multiple Plots View

5. **Plot pane** – Displays the selected analysis screen for the open experiment.

6. **View tabs** – Displays the Plate Layout or Well Table for the open experiment.

7. **Experiment tab(s)** – Displays a tab for each open experiment.
Navigation Tips

How to Select Wells

To display specific wells in the analysis screens, select the wells in the View Plate Layout tab as follows:

1. To select wells of a specific type, use the Select Wells With dropdown menus: Select Sample, Target, or Task, then select the sample, target, or task name.

2. To select one well, click the well in the plate layout.

3. To select multiple wells, click and drag over the desired wells, press CTRL+click, or press Shift+click in the plate layout.

4. To select all 48 wells, click the top left corner of the plate layout.
How To Display Multiple Plots

Use the Multiple Plots view to display up to four plots simultaneously. To navigate within the Multiple Plots view:

1. From the Experiment Menu pane, select Analysis ▶ Multiple Plots View.
2. To display four plots, click Show plots in a 2 × 2 matrix.
3. To display two plots in rows, click Show plots in two rows.
4. To display two plots in columns, click Show plots in two columns.
5. To display a specific plot, select the plot from the dropdown menu above each plot display.
View the Presence/Absence Plot

The Presence/Absence plot displays the intensity of the fluorescence for each well position. There are four Presence/Absence plot views available:

- All Calls
- Presence calls only
- Absence calls only
- Unconfirmed calls

For each view, you can choose to:

- Show IPC
- Show Controls

About the Example Experiment

In the presence/absence experiment:

- The target is absent in samples Unknown 1, Unknown 2, and Unknown 3.
- The target is present in samples Unknown 4 and Unknown 5.
- There are no unconfirmed wells.
- The IPC succeeded in all wells.

View the Presence/Absence Plot

1. From the Experiment Menu pane, select Analysis ➤ Presence/Absence Plot.
   
   Note: If no data are displayed, click Analyze.

2. For an expanded display of the 48 wells of the Presence/Absence screen, click the upper left corner of the plate layout in the View Plate Layout tab.

3. From the Target Reporter dropdown menu, select Pathogen.

4. From the Control Reporter dropdown menu, select IPC.

5. From the Show Calls dropdown menu, select All Calls.

6. Click the Show a legend for the plot (default).
   
   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

7. Click the Show IPC checkbox to view the fluorescence intensity of the IPC target in the Unknown-IPC wells.

8. Click the Show Controls checkbox to view the fluorescence intensity of the IPC target in the Negative Control-IPC wells and the Negative Control-Blocked IPC wells.

9. To view the fluorescence intensity of only the presence calls, select Presence from the Show Calls dropdown menu.
10. To view the fluorescence intensity of only the absence calls, select **Absence** from the Show Calls dropdown menu.

11. To view the fluorescence intensity of only the unconfirmed calls, select **Unconfirmed** from the dropdown menu.

**Note:** The Presence/Absence example experiment does not contain any unconfirmed calls.

---

**Analysis Guidelines**

When you analyze your own experiment, review the presence/absence plot for:

- **The IPC threshold** – this value is calculated from the Negative Control- Blocked IPC reactions.

- **The Target Threshold** – this value is calculated from the Negative Control- IPC reactions. If the target’s intensity is:
  - Above the target threshold, the call is present (regardless of the intensity of the IPC).
  - Below the target threshold, and the IPC’s intensity is above the IPC threshold, the call is absent.
  - Below the target threshold, and the IPC’s intensity is below the IPC threshold, the call is unconfirmed.
Chapter 5  Analyze the Experiment

View the Amplification Plot

- **Target Calls:**
  - Presence
  - Absence
  - Unconfirmed

- **IPC Calls:**
  - IPC Succeeded
  - IPC Failed

- **Control Well Calls:**
  - Negative Control - IPC

For more information on the Presence/Absence Plot screen, access the StepOne Software Help by clicking 🌐 or pressing F1.

View the Amplification Plot

The amplification plot displays amplification of all samples in the selected wells. There are three amplification plot views available:

- **ΔRn vs Cycle** – ΔRn is the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. This plot displays ΔRn as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

- **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. You can use this plot to identify and examine irregular amplification.

- **Cₜ vs Well** – Cₜ is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays Cₜ as a function of well position. You can use this plot to locate outlying amplification (outliers).

**IMPORTANT!** Amplification plots are not used to make presence/absence calls. Examine the plots to help with troubleshooting and quality control.

About the Example Experiment

In the presence/absence example experiment, you review the amplification plot for:

- Correct baseline and threshold values
- Irregular amplification
- Outliers
Chapter 5  Analyze the Experiment

View the Amplification Plots

1. From the Experiment Menu pane, select Analysis → Amplification Plot.

   Note: If no data are displayed, click Analyze.

2. Display all 48 wells in the amplification plot by clicking the upper left corner of the plate layout in the View Plate Layout tab.

3. Expand the View Plate Layout tab by clicking the left facing arrow that is left of the tab.

![Amplification Plot Screen]

4. In the Amplification Plot screen:
   a. From the Plot Type dropdown menu, select ΔRn vs Cycle.
   b. From the Plot Color dropdown menu, select Well.
   c. Click the Show a legend for the plot (default).

   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. View the baseline values:
   a. From the Graph Type dropdown menu, select Linear.
   b. Select the Baseline checkbox to show the start cycle and end cycle.
   c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.

Notes
6. View the threshold values:
   a. From the Graph Type dropdown menu, select Log.
   b. Select the Threshold checkbox to show the threshold.
   c. Verify that the threshold is set correctly.
7. Locate any outliers:
   a. From the Plot Type dropdown menu, select $C_T$ vs Well.
   b. Look for outliers from the amplification plot.

![Amplification Plot]

**Analysis Guidelines**

When you analyze your own presence/absence experiment, look for:

- Outliers
- A typical amplification plot – The StepOne software calculates baseline and threshold values based on the assumption that the data exhibit a *typical* amplification curve. A typical amplification plot has four distinct sections:
  a. Plateau phase
  b. Linear phase
  c. Exponential (geometric phase)
  d. Baseline
IMPORTANT! Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the StepOne software. Therefore, Applied Biosystems recommends that you examine the Amplification Plot and review the assigned baseline and threshold values for each well after analysis completes.

- Correct baseline and threshold values – See the threshold examples on page 91 and the baseline examples on page 92.
Threshold Set Correctly
The threshold is set in the exponential phase of the amplification curve.
Threshold settings above or below the optimum increase the standard deviation of the replicate groups.

Threshold Set Too Low
The threshold is set below the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar up into the exponential phase of the curve.

Threshold Set Too High
The threshold is set above the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar down into the exponential phase of the curve.
**Baseline Set Correctly**
The amplification curve begins after the maximum baseline.

**Baseline Set Too Low**
The amplification curve begins too far to the right of the maximum baseline. Increase the End Cycle value.

**Baseline Set Too High**
The amplification curve begins before the maximum baseline. Decrease the End Cycle value.

If your experiment does not meet the guidelines above, troubleshoot as follows:
- Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on page 98).
  
  or

- Omit wells, (see “Omit Wells from the Analysis” on page 102).

**For More Information**
For more information on the Amplification Plot screen, access the StepOne Software Help by clicking 🏛 or pressing F1.
**View the Well Table**

The Well Table displays results data for each well in the reaction plate, including:

- The well number, sample name, target name, task, and dyes
- The calculated values: \( \Delta R_n \), \( \Delta R_n \) mean, and \( \Delta R_n \) SD

**Note:** \( \Delta R_n \), \( \Delta R_n \) mean, and \( \Delta R_n \) SD are calculated only when the analysis call settings specify to analyze data from the pre-PCR read and the post-PCR read.

- Target and IPC thresholds, Call, Comments
- Flags

**About the Example Experiment**

In the presence/absence example experiment, you review the Well Table for:

- Call
- \( \Delta R_n \)
- Flag

**View the Well Table**

1. From the Experiment Menu pane, select **Analysis**, then select the **View Well Table** tab.

   **Note:** If no data are displayed, click **Analyze**.

2. Use the Group By dropdown menu to group wells by a specific category. For the example experiment, group the wells by flag, call, and \( \Delta R_n \) value.

   **Note:** You can select only one category at a time.

   a. From the Group By dropdown menu, select **Flag**:

      - None of the wells are listed under Flagged.
      - All the wells are listed under Unflagged.
b. From the Group By dropdown menu, select Call. Wells are listed in the order:

- Absence
- Blocked IPC Control
- IPC Succeeded
- Negative Control
- Presence
- Unconfirmed
- IPC Failed

Notes
c. From the Group By dropdown menu, select None. In the table, click the column heading $\Delta R_n$. Wells are listed in order of increasing $\Delta R_n$. Click the column heading again to reverse the sort order.
Chapter 5  Analyze the Experiment

Publish the Data

Analysis Guidelines

When you analyze your own presence/absence experiment, group the wells by:

- **Flag** – The software groups the flagged and unflagged wells. A flag indicates that the software has found an error in the flagged well. For a description of the StepOne software flags, see “View the QC Summary” on page 100.
- **Call** – The software groups the wells by call: Negative Control, Blocked-IPC, Presence, Absence, Unconfirmed, IPC Succeeded, and IPC Failed.

For More Information

For more information on the Well Table, access the StepOne Software Help by clicking 🌐 or pressing F1.

Publish the Data

You can publish the experiment data in several ways:

- Save the plot as an image file
- Print the plot
- Print the plate layout
- Create slides
- Print a report
- Export data

For More Information

For information on performing these procedures, access the StepOne Software Help by clicking 🌐 or pressing F1.
Section 5.2 Troubleshoot (If Needed)

This section covers:

- View the Analysis Settings ............................................................ 98
- View the QC Summary ............................................................... 100
- Omit Wells from the Analysis ....................................................... 102
- View the Multicomponent Plot ...................................................... 103
- View the Raw Data Plot .............................................................. 105
View the Analysis Settings

The Analysis Settings dialog box displays the analysis settings for the call settings, threshold cycle ($C_T$), and flags. If the default analysis settings in the StepOne software, are not suitable for your experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

About the Example Experiment

In the presence/absence example experiment, the default analysis settings are used without changes.

Review the Analysis Settings

1. From the Experiment Menu pane, select **Analysis**.

2. Click **Analysis Settings** to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:

- Call Settings
- $C_T$ Settings
- Flag Settings

![Analysis Settings dialog box](image-url)

Notes
Analysis Guidelines

Unless you have already determined the optimal settings for your experiment, use the default analysis settings in the StepOne software. If the default settings are not suitable for your experiment, you can change the:

- **Call Settings** – Use this tab to specify whether to analyze data from the pre-PCR read or to edit the default confidence value used to make presence/absence calls for each target.

- **CT Settings** (if the experiment includes amplification) – Use this tab to set the threshold and baseline either automatically or manually. When you manually set the threshold and baseline, keep the following Applied Biosystems recommendations in mind:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select Start Cycle and End Cycle values so that the baseline ends before</td>
</tr>
<tr>
<td></td>
<td>significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

- **Flag Settings** – Use this tab to:
  - Adjust the sensitivity so that more wells or fewer wells are flagged.
  - Change the flags that are applied by the StepOne software.

For More Information

For more information on the analysis settings, access the StepOne Software Help by clicking 🛠️ or pressing F1 when the Analysis Settings dialog box is open.
View the QC Summary

The QC Summary displays a list of the StepOne software flags. This summary includes the flag frequency and location for the open experiment.

About the Example Experiment

In the presence/absence example experiment, you review the QC Summary for any flags triggered by the experiment data. In the example experiment, no flags have been triggered.

View the QC Summary

1. From the Experiment Menu pane, select Analysis ➤ QC Summary.
   
   **Note:** If no data are displayed, click Analyze.

2. Review the Flags Summary. In the example experiment, there are 0 flagged wells.

3. In the Flag Details table, look in the Frequency and Wells columns to determine which flags appear in the experiment. In the example experiment, the Frequency column displays 0 for all the flags.
   
   **Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment.

4. (Optional) Click each flag row to display detailed information about the flag.

---

**QC Summary**

<table>
<thead>
<tr>
<th>Flag Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Wells: 48</td>
</tr>
<tr>
<td>Wells Set Up: 48</td>
</tr>
<tr>
<td>Processed Wells: 48</td>
</tr>
<tr>
<td>Targets Used: 2</td>
</tr>
<tr>
<td>Flagged Wells: 0</td>
</tr>
<tr>
<td>Samples Used: 5</td>
</tr>
</tbody>
</table>

**Flag Details**

<table>
<thead>
<tr>
<th>Flag</th>
<th>Name</th>
<th>Frequency</th>
<th>Wells</th>
</tr>
</thead>
<tbody>
<tr>
<td>BADRCE</td>
<td>Bad passive reference signal</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>ERROR</td>
<td>No signal in well</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Amplification is off scale</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>QVALUE</td>
<td>Noise spikes</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>QFPAF</td>
<td>Experimental algorithm failed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>BLSFAF</td>
<td>Baseline algorithm failed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>THDFAF</td>
<td>Thresholding algorithm failed</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

---

**Flag:** BADRCE—Bad passive reference signal

**Flag Detail:** Passive reference signal is abnormal

**Flag Criteria:** Fluorescence < 500.0

**Flagged Wells:** None

---

Notes
Possible Flags

For presence/absence experiments, the flags listed below may be triggered by the experiment data.

Note: If the experiment does not include amplification, then the only flags are BADROX, NOSIGNAL, and OFFSCALE.

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>C_T algorithm failed</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
</tbody>
</table>

Analysis Guidelines

When you analyze your own presence/absence experiment:

- Click each flag in the Flag Details table with a frequency >0 to display detailed information about the flag. If needed, click the troubleshooting link to view information on correcting the flag.
- You can change the flag settings:
  - Adjust the sensitivity so that more wells or fewer wells are flagged.
  - Change the flags that are applied by the StepOne software.

For More Information

For more information on the QC Summary screen or on flag settings, access the StepOne Software Help by clicking 📖 or pressing F1.
Chapter 5  Analyze the Experiment
Omit Wells from the Analysis

You may omit wells from analysis if you do not want to consider data generated by the well.

About the Example Experiment
In the presence/absence example experiment, there are no outliers; no wells need to be removed from analysis.

Omit Wells
1. Click the View Plate Layout tab.
2. Select one or more wells to omit from analysis.
3. Right-click the well(s), then select Omit. Results for the well are removed.

Analysis Guidelines
When you analyze your own presence/absence experiment, carefully consider which wells to omit from analysis. If needed, remove outliers manually using the Well Table.

1. From the Experiment Menu pane, select Analysis ▶ Amplification Plot.

   Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select $C_T$ vs Well from the Plot Type dropdown menu.

3. Select the View Well Table tab.

Notes
Chapter 5 Analyze the Experiment

View the Multicomponent Plot

For More Information

4. Review the Well Table:
   a. Look for any outliers.
   b. Select the Omit checkbox next to the outlying well(s).

5. Click Analyze to reanalyze the experiment data with the outlying well(s) removed from the analysis.

For more information on omitting wells from the analysis, access the StepOne Software Help by clicking ☰ or pressing F1. Within the Help, search for the omit well topics:

1. Click the Search tab.
2. Enter omit well.
3. Click List Topics.
4. Double-click the topics you want to review.

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of a PCR run.

About the Example Experiment

In the presence/absence example experiment, you review the Multicomponent Plot for:
- ROX™ dye
- VIC® dye
- FAM™ dye
- Spikes, dips, and/or sudden changes.
- Amplification in the negative control wells.

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis ➝ Multicomponent Plot.
   
   Note: If no data are displayed, click Analyze.

2. Display the wells one at a time in the Multicomponent Plot screen:
   a. Click the View Plate Layout tab.
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.

   Note: If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color dropdown menu, select Dye.
4. Click the **Show a legend for the plot** (default).

**Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the run.

6. Check the VIC dye signal. In the example experiment the VIC dye signal should not amplify for NC-Blocked IPC wells or if the IPC call for the Unknown-IPC well is IPC Failed.

7. Check the FAM dye signal. In the example experiment, the FAM dye should amplify for Unknown-IPC wells that receive a target call of Presence.

---

### Analysis Guidelines

When you analyze your own presence/absence experiment, look for:

- **Passive reference (ROX)** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.

- **Reporter dye (FAM)** – The reporter dye fluorescence level should display a flat region corresponding to the baseline. If target is present in the sample (a Presence call is made), the baseline will be followed by a rapid rise in fluorescence as the amplification proceeds.

- **Any irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.

- **Negative control wells** – There should not be any amplification in the negative control wells.

---

**Notes**
For More Information
For more information on the Multicomponent Plot screen, access the StepOne Software Help by clicking 📉 or pressing F1.

View the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

About the Example Experiment
In the presence/absence example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis ➤ Raw Data Plot.

   Note: If no data are displayed, click Analyze.

2. Click the Show a legend for the plot (default).

   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

   Note: The legend displays the color code for each row of the reaction plate.

3. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the View Plate Layout tab.

4. Select wells corresponding to a replicate group:
   - Unknown 1 wells: From the Select Wells with dropdown menus, select Sample and Unknown 1.
   - Unknown 2 wells: From the Select Wells with dropdown menus, select Sample and Unknown 2.
   - Unknown 3 wells: From the Select Wells with dropdown menus, select Sample and Unknown 3.
   - Unknown 4 wells: From the Select Wells with dropdown menus, select Sample and Unknown 4.
   - Unknown 5 wells: From the Select Wells with dropdown menus, select Sample and Unknown 5.
   - Negative control-IPC wells: Select wells A5, A6, A7, and A8.
   - Negative control-blocked IPC wells: Select wells A1, A2, A3, and A4.

5. Click and drag the Show Cycle pointer from cycle 1 to cycle 40, and review the data from each filter:
   - The data from filter 1 correspond to the signal from FAM™ dye, the reporter for the pathogen target. Increase indicates amplification of the target.
- The data from filter 2 correspond to the signal from VIC® dye, the reporter for the IPC target. Increase indicates amplification of the IPC.
- The data from filter 3 correspond to the signal from ROX™ dye, which is used as the passive reference.

6. Repeat steps 4 and 5 for each replicate group.

The filters are:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Dye</th>
<th>Filter</th>
<th>Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAM™ dye</td>
<td>1</td>
<td>FAM™ dye</td>
</tr>
<tr>
<td></td>
<td>SYBR® Green dye</td>
<td></td>
<td>SYBR® Green dye</td>
</tr>
<tr>
<td>2</td>
<td>JOE™ dye</td>
<td>2</td>
<td>JOE™ dye</td>
</tr>
<tr>
<td></td>
<td>VIC® dye</td>
<td></td>
<td>VIC® dye</td>
</tr>
<tr>
<td>3</td>
<td>ROX™ dye</td>
<td>3</td>
<td>TAMRA™ dye</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NED™ dye</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ROX™ dye</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
When you analyze your own presence/absence experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips

For more information on the Raw Data Plot screen, access the StepOne Software Help by clicking 📚 or pressing F1.
Alternate Experiment Workflows

This appendix covers:

- Advanced Setup Workflow .................................................. 110
- QuickStart Workflow ............................................................ 111
- Template Workflow .............................................................. 113
- Export/Import Workflow ....................................................... 115

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by pressing F1, clicking 📚 in the toolbar, or selecting Help ➤ StepOne Software Help.
Advanced Setup Workflow

When you create an experiment using Advanced Setup in the StepOne™ software, you can set up the experiment according to your own design.

1. Double-click (StepOne software shortcut) or select Start ▶ All Programs ▶ Applied Biosystems ▶ StepOne Software ▶ <software name>

   where <software name> is the current version of the StepOne software.

2. From the Home screen, click Advanced Setup.

   Note: If you do not see the Advanced Setup icon, click the arrow beneath the Design Wizard icon to expand the Set Up menu.

3. Complete the setup screens to set up a new experiment:
   a. Click Experiment Properties (default), enter the experiment name, then select the experiment properties.
   b. Click Plate Setup:

      | Experiment Type       | Action                                                                 |
      |-----------------------|------------------------------------------------------------------------|
      | Genotyping            | Define the SNP assays, then assign them to wells in the reaction plate. |
      | All other experiments | Define the targets, then assign them to wells in the reaction plate.   |

   c. Click Run Method, review the reaction volume and thermal profile, then edit as needed.
   d. Click Reaction Setup, review the components and calculated volumes for the PCR reactions, then edit as needed.
   e. (Optional) Click Materials List, review the list of materials, then order the materials you need to prepare the reaction plate.

4. Prepare the PCR reactions:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td>Standard curve</td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
</tbody>
</table>
5. Run the experiment:
   a. Load the reaction plate into the instrument.
   b. Start the run
   c. (Optional) Monitor the run.
   d. Unload the reaction plate from the instrument.

6. Analyze the data:
   a. Open the experiment in the StepOne software.
   b. From the Experiment Menu, click Analysis.
   c. If the data are not analyzed, click Analyze.
   d. In the navigation pane, select an analysis screen to view the data (for example, select QC Summary to view a quality summary of the data).

QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td></td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
<tr>
<td>Standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td></td>
<td>c. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction plate.</td>
</tr>
<tr>
<td>Comparative $C_T$</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td>Genotyping</td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td>Presence/absence</td>
<td>c. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction plate.</td>
</tr>
</tbody>
</table>
2. QuickStart the experiment:
   a. Double-click (StepOne software shortcut) or select
      Start ▶ All Programs ▶ Applied Biosystems ▶ StepOne Software ▶
      <software name>
      where <software name> is the current version of the StepOne software.
   b. From the Home screen, click QuickStart.
   c. Select the Experiment Properties tab (default), enter the experiment name,
      then select the experiment properties.
   d. Select the Run Method tab, review the reaction volume and thermal profile,
      then edit as needed.
3. Run the experiment:
   a. Load the reaction plate into the instrument.
   b. Start the run
   c. (Optional) Monitor the run.
   d. Unload the reaction plate from the instrument.
4. In the StepOne software, complete the plate setup:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genotyping</td>
<td>a. Select and complete the Define SNP Assays and Samples tab.</td>
</tr>
<tr>
<td></td>
<td>b. Select and complete the Assign SNP Assays and Samples tab.</td>
</tr>
<tr>
<td>All other experiments</td>
<td>a. Select and complete the Define Targets and Samples tab.</td>
</tr>
<tr>
<td></td>
<td>b. Select and complete the Assign Targets and Samples tab.</td>
</tr>
</tbody>
</table>

5. Analyze the data:
   a. Open the experiment in the StepOne software.
   b. From the Experiment Menu, click Analysis.
   c. If the data are not analyzed, click Analyze.
   d. In the navigation pane, select an analysis screen to view the data (for example, select QC Summary to view a quality summary of the data).
Template Workflow

You can use a template to create a new experiment. Templates are useful when you want to create many experiments with the same setup information.

Create a Template

1. Double-click (StepOne software shortcut) or select Start ➤ All Programs ➤ Applied Biosystems ➤ StepOne Software ➤ <software name>
   where <software name> is the current version of the StepOne software.

2. Open an existing experiment, or create a new experiment.
   
   **Note:** You can create a new experiment using the Design Wizard (see Chapter 2) or Advanced Setup (see page 110).

3. Select File ➤ Save As Template.

4. Enter a file name, select a location for the template, then click Save.

5. Click Close.

Create an Experiment with a Template

1. From the Home screen, click Template.
   
   **Note:** If you do not see the Template icon, click the arrow beneath the Design Wizard icon to expand the Set Up menu.

2. Locate and select the template you created in step d, then click Open. A new experiment is created using the setup information from the template:
   - Experiment properties
   - Plate setup
   - Run method
   - Reaction setup

3. *(Optional)* If you want to modify the experiment, use Advanced Setup (see page 110).

4. Click Save, enter a file name, then click Save to save the experiment.

5. Prepare the PCR reactions:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td>Standard curve</td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
</tbody>
</table>

Notes
6. Run the experiment:
   a. Load the reaction plate into the instrument.
   b. Start the run
   c. (Optional) Monitor the run.
   d. Unload the reaction plate from the instrument.

7. Analyze the data:
   a. Open the experiment in the StepOne software.
   b. From the Experiment Menu, click Analysis.
   c. If the data are not analyzed, click Analyze.
   d. In the navigation pane, select an analysis screen to view the data (for example, select QC Summary to view a quality summary of the data).

---

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparative Cₜ</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td>Genotyping</td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td>Presence/absence</td>
<td>c. Prepare the reaction mix.</td>
</tr>
<tr>
<td>Presence/absence</td>
<td>d. Prepare the reaction plate.</td>
</tr>
</tbody>
</table>
Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported from another experiment. Only reaction plate setup data are exported and imported.

**Note:** Setup data exported from experiments in StepOne Software v1.0 can be imported into experiments in StepOne Software v2.0 or later. However, setup data exported from experiments in StepOne Software v2.0 or later cannot be imported into experiments in StepOne Software v1.0.

---

Export Setup Data

1. Double-click ☑ (StepOne software shortcut) or select `Start ➤ All Programs ➤ Applied Biosystems ➤ StepOne Software ➤ <software name>`
   where `<software name>` is the current version of the StepOne software.

2. Open an existing experiment, or create a new experiment.

   **Note:** You can create a new experiment using the Design Wizard (see Chapter 2) or Advanced Setup (see page 110).


4. Select the Export Properties tab (default), then:
   a. Select Setup.
   b. Select One File from the dropdown menu.
   c. Enter a name, then select a location for the export file.
   d. Select `(*.txt)` from the File Type dropdown menu.

   **IMPORTANT!** You cannot export *.xml files.

5. *(Optional)* Click the Customize Export tab, then select the appropriate options.

6. Click Start Export,

7. When prompted, click Close Export Tool.

---

Create an Experiment with an Exported Text File

You can import plate setup data from an exported text file (*.txt) to complete the reaction plate setup data for your experiment.

**IMPORTANT!** Be sure the exported text file you select contains only reaction plate setup data and that the experiment types match.
Appendix A  Alternate Experiment Workflows

Export/Import Workflow

1. Import the reaction plate setup data from an exported text file:
   
   a. Using a spreadsheet application (such as Microsoft® Excel software), open an exported text file.
   
   b. Replace the parameters of the text file as needed. When finished, save the file as a tab-delimited text file.
   
   c. From the Home screen, click Advanced Setup.

   **Note:** If you do not see the Advanced Setup icon, click the arrow beneath the Design Wizard icon to expand the Set Up menu.

   d. Create a new experiment or open an existing experiment.

   e. Select File ▶ Import.

   f. Click Browse, locate and select the text file (*.txt), then click Select.

   g. Click Start Import. The setup data from the exported text file is imported into the open experiment.

   **Note:** If your experiment already contains plate setup information, the software asks if you want to replace the plate setup with the data from the text file. Click Yes to replace the plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 110).

3. Prepare the PCR reactions:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td>Standard curve</td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
<tr>
<td>Comparative C&lt;sub&gt;T&lt;/sub&gt;</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td>Genotyping</td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td>Presence/absence</td>
<td>c. Prepare the reaction mix.</td>
</tr>
</tbody>
</table>
<pre><code>                                              | d. Prepare the reaction plate.|
</code></pre>

4. Run the experiment:

   a. Load the reaction plate into the instrument.

   b. Start the run

   c. *(Optional)* Monitor the run.

   d. Unload the reaction plate from the instrument.

**Notes**
5. Analyze the data:
   a. Open the experiment in the StepOne software.
   b. From the Experiment Menu, click Analysis.
   c. If the data are not analyzed, click Analyze.
   d. In the navigation pane, select an analysis screen to view the data (for example, select QC Summary to view a quality summary of the data).
Bibliography

Advanced Setup

In the StepOne™ software, a feature that allows you to set up your experiment according to your experiment design. Advanced Setup provides you with maximum flexibility in the design and setup of your experiment.

AIF

See assay information file (AIF).

allele

For a given target, any of the different sequences that occurs in the population.

allelic discrimination plot

Display of data collected during the post-PCR read. The allelic discrimination plot is a graph of the normalized reporter signal from the allele 1 probe plotted against the normalized reporter signal from the allele 2 probe.

amplicon

A segment of DNA amplified during PCR.

amplification

Part of the instrument run in which PCR produces amplification of the target. For quantitation experiments, fluorescence data collected during amplification are displayed in an amplification plot, and the data are used to calculate results. For genotyping or presence/absence experiments, fluorescence data collected during amplification are displayed in an amplification plot, and the data can be used for troubleshooting.

amplification efficiency (EFF%)

Calculation of efficiency of the PCR amplification. The amplification efficiency is calculated using the slope of the regression line in the standard curve. A slope close to $-3.32$ indicates optimal, 100% PCR amplification efficiency. Factors that affect amplification efficiency:

- **Range of standard quantities** – To increase the accuracy and precision of the efficiency measurement, use a broad range of standard quantities, 5 to 6 logs ($10^5$ to $10^6$ fold).
- **Number of standard replicates** – To increase the precision of the standard quantities and decrease the effects of pipetting inaccuracies, include replicates.
- **PCR inhibitors** – PCR inhibitors in the reaction can reduce amplification and alter measurements of the efficiency.

amplification plot

Display of data collected during the cycling stage of PCR amplification. Can be viewed as:

- Baseline-corrected normalized reporter ($\Delta R_n$) vs. cycle
- Normalized reporter ($R_n$) vs. cycle
- Threshold cycle ($C_T$) vs. well
amplification stage  Part of the instrument run in which PCR produces amplification of the target. The amplification stage is called a cycling stage in the thermal profile and consists of denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage are displayed in an amplification plot, and the data are used to calculate results. For genotyping or presence/absence experiments, fluorescence data collected during the amplification stage are displayed in an amplification plot, and the data can be used for troubleshooting. See also cycling stage.

assay  In the StepOne™ and StepOnePlus™ systems, a PCR reaction mix that contains primers to amplify a target and a reagent to detect the amplified target.

Assay ID  Identifier assigned by Applied Biosystems to TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays.

assay information file (AIF)  Data file on a CD shipped with each assay order. The file name includes the number from the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

assay mix  PCR reaction component in Applied Biosystems TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify a target and a TaqMan® probe designed to detect amplification of the target.

AutoDelta  In the run method, a setting to increase or decrease the temperature and/or time for a step with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling stage, the settings are indicated by an icon in the thermal profile:

- AutoDelta on: ▲
- AutoDelta off: ▲

automatic baseline  An analysis setting in which the software calculates the baseline start and end values for the amplification plot. You can apply the automatic baseline setting to specific wells in the reaction plate. See also baseline.

automatic $C_T$  An analysis setting in which the software calculates the baseline start and end values and the threshold in the amplification plot. The software uses the baseline and threshold to calculate the threshold cycle ($C_T$). See also threshold cycle ($C_T$).

baseline  In the amplification plot, a line fit to the fluorescence levels during the initial stages of PCR, when there is little change in fluorescence signal.
**baseline-corrected normalized reporter (ΔRn)**

The magnitude of normalized fluorescence signal generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. In the ΔRn vs. Cycle amplification plot, ΔRn is calculated at each cycle as:
   \[ \Delta R_n (\text{cycle}) = R_n (\text{cycle}) - R_n (\text{baseline}), \text{ where } R_n = \text{normalized reporter} \]

2. In genotyping experiments and presence/absence experiments, the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. In the allelic discrimination plot (genotyping experiments) and the presence/absence plot (presence/absence experiments), ΔRn is calculated as:
   \[ \Delta R_n = R_n (\text{post-PCR read}) - R_n (\text{pre-PCR read}), \text{ where } R_n = \text{normalized reporter} \]

See also normalized reporter (Rn).

**blocked IPC**

In presence/absence experiments, a reaction that contains IPC blocking agent, which blocks amplification of the internal positive control (IPC). In the StepOne™ software, the task for the IPC target in wells that contain IPC blocking agent. See also negative control-blocked IPC wells.

**calibrator**

See reference sample.

**chemistry**

See reagents.

**colocated layout**

A system layout in which the StepOne™ or StepOnePlus™ instrument is directly connected to a colocated computer by the yellow cable. In this layout, you can control the instrument with the StepOne™ software on the colocated computer or with the instrument touchscreen.

**comparative C_T (ΔΔC_T) method**

Method for determining relative target quantity in samples. With the comparative C_T (ΔΔC_T) method, the StepOne™ software measures amplification of the target and of the endogenous control in samples and in a reference sample. Measurements are normalized using the endogenous control. The software determines the relative quantity of target in each sample by comparing normalized target quantity in each sample to normalized target quantity in the reference sample.

**C_T**

See threshold cycle (C_T).

**custom dye**

Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in experiments on the StepOne™ and StepOnePlus™ systems. When using custom dyes, the custom dye should be added to the Dye Library and a custom dye calibration performed.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

**cycle threshold**

See threshold cycle (C_T).
cycling stage

In the thermal profile, a stage that is repeated. A cycling stage is also called an amplification stage. For cycling stages, you can enable AutoDelta settings. See also amplification stage.

data collection

A process during the instrument run in which an instrument component detects fluorescence data from each well of the reaction plate. The instrument transforms the signal to electronic data, and the data are saved in the experiment file. In the StepOne™ software, a data collection point is indicated by an icon in the thermal profile:

- Data collection on: 
- Data collection off: 

delta Rn (ΔRn)

See baseline-corrected normalized reporter (ΔRn).

derivative reporter (–Rn')

The negative first-derivative of the normalized fluorescence generated by the reporter during PCR amplification. In the derivative reporter (–Rn’) vs. temperature melt curve, the derivative reporter signal is displayed in the y-axis.

Design Wizard

A feature in the StepOne™ software that helps you set up your experiment by guiding you through best practices as you enter your experiment design.

diluent

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The diluent can be water or buffer.

Diluted Sample Concentration (10× for Reaction Mix)

In the StepOne™ software, a field displayed on the Sample Dilution Calculations tab of the Reaction Setup screen. For this field, enter the sample concentration you want to use to add to the reaction mix for all samples in the experiment. “10× for Reaction Mix” indicates that the software assumes the sample or standard component of the reaction mix is at a 10X concentration. For example, if the diluted sample concentration is 50.0 ng/μL (10×), the final sample concentration in the reaction is 5 ng/μL (1×).

dilution factor

See serial factor.

dissociation curve

See melt curve.

EFF%

See amplification efficiency (EFF%).

endogenous control

A target or gene that should be expressed at similar levels in all samples you are testing. Endogenous controls are used in relative standard curve and comparative C_T (ΔΔC_T) experiments to normalize fluorescence signals for the target you are quantifying. Housekeeping genes can be used as endogenous controls. See also housekeeping gene.

endpoint read

See post-PCR read.
**experiment**
Refers to the entire process of performing a run using the StepOne™ or StepOnePlus™ systems, including setup, run, and analysis. The types of experiments you can perform using the StepOne and StepOnePlus systems:

- Quantitation - standard curve
- Quantitation - relative standard curve
- Quantitation - comparative C_T (ΔΔC_T)
- Melt curve
- Genotyping
- Presence/absence

**experiment name**
Entered during experiment setup, the name that is used to identify the experiment. Experiment names cannot exceed 100 characters and cannot include any of the following characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

**experiment type**
The type of experiment you are performing using the StepOne™ or StepOnePlus™ system:

- Standard curve
- Comparative C_T (ΔΔC_T)
- Relative standard curve
- Melt curve (not available in the Design Wizard)
- Genotyping
- Presence/absence

The experiment type you select affects the setup, run, and analysis.

**forward primer**
Oligonucleotide that flanks the 5’ end of the amplicon. The reverse primer and the forward primer are used together in PCR reactions to amplify the target.

**holding stage**
In the thermal profile, a stage that includes one or more steps. You can add a holding stage to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

**housekeeping gene**
A gene that is involved in basic cellular functions and is constitutively expressed. Housekeeping genes can be used as endogenous controls. See also endogenous control.

**internal positive control (IPC)**
In presence/absence experiments, a short synthetic DNA template that is added to PCR reactions. You can use the IPC to distinguish between true negative results (that is, the target is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay setup, or reagent or instrument failure.

**inventoried assays**
TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays that have been previously manufactured, passed quality control specifications, and stored in inventory.

**IPC**
In presence/absence experiments, abbreviation for internal positive control (IPC). In the StepOne™ software, the task for the IPC target in wells that contain the IPC and do not contain IPC blocking agent. See also internal positive control (IPC).

**IPC blocking agent**
Reagent added to PCR reactions to block amplification of the internal positive control (IPC).
### Glossary

**IPC+**
See negative control-IPC wells.

**made-to-order assays**
TaqMan® Gene Expression Assays or TaqMan® SNP Genotyping Assays that are manufactured at the time of order. Only assays that pass manufacturing quality control specifications are shipped.

**manual baseline**
An analysis setting in which you enter the baseline start and end values for the amplification plot. You can apply the manual baseline setting to specific wells in the reaction plate.

**manual CT**
An analysis setting in which you enter the threshold value and select whether to use automatic baseline or manual baseline values. The software uses the baseline and the threshold values to calculate the threshold cycle (C_T).

**melt curve**
A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate the melting temperature (Tm) of the target or can identify nonspecific PCR amplification. In the StepOne™ software, you can view the melt curve as normalized reporter (Rn) vs. temperature or as derivative reporter (−Rn’) vs. temperature. Also called dissociation curve.

**melt curve stage**
In the thermal profile, a stage with a temperature increment to generate a melt curve.

**melting temperature (Tm)**
In melt curve experiments, the temperature at which 50% of the DNA is double-stranded and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the melt curve.

**multicomponent plot**
A plot of the complete spectral contribution of each dye for the selected well(s) over the duration of the PCR run.

**negative control (NC)**
In the StepOne™ software, the task for targets or SNP assays in wells that contain water or buffer instead of sample. No amplification of the target should occur in negative control wells. Previously called no template control (NTC).

**negative control-blocked IPC wells**
In presence/absence experiments, wells that contain IPC blocking agent instead of sample in the PCR reaction. No amplification should occur in negative control-blocked IPC wells because the reaction contains no sample and amplification of the IPC is blocked. Previously called no amplification control (NAC).

**negative control-IPC wells**
In presence/absence experiments, wells that contain IPC template and buffer or water instead of sample. Only the IPC template should amplify in negative control-IPC wells because the reaction contains no sample. Previously called IPC+.

**no amplification control (NAC)**
See negative control-blocked IPC wells.

**no template control (NTC)**
See negative control (NC).
**nonfluorescent quencher-minor groove binder (NFQ-MGB)**

Molecules that are attached to the 3’ end of TaqMan® probes. When the probe is intact, the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence signal. Because the NFQ does not fluoresce, it produces lower background signals, resulting in improved precision in quantitation. The minor groove binder (MGB) increases the melting temperature (Tm) without increasing probe length. It also allows the design of shorter probes.

**normalized quantity**

Quantity of target divided by the quantity of endogenous control.

**normalized reporter (Rn)**

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the passive reference.

**omit well**

An action that you perform before reanalysis to omit one or more wells from analysis. Because no algorithms are applied to omitted wells, omitted wells contain no results.

**outlier**

For a set of data, a datapoint that is significantly smaller or larger than the others.

**passive reference**

A dye that produces fluorescence signal. Because the passive reference signal should be consistent across all wells, it is used to normalize the reporter dye signal to account for non-PCR related fluorescence fluctuations caused by minor well-to-well differences in concentrations or volume. Normalization to the passive reference signal allows for high data precision.

**plate layout**

An illustration of the grid of wells and assigned content in the reaction plate. In StepOne™ systems, the grid contains 6 rows and 8 columns. In StepOnePlus™ systems, the grid contains 8 rows and 12 columns.

In the StepOne™ software, you can use the plate layout as a selection tool to assign well contents, to view well assignments, and to view results. The plate layout can be printed, included in a report, exported, and saved as a slide for a presentation.

**point**

One standard in a standard curve. The standard quantity for each point in the standard curve is calculated based on the starting quantity and serial factor.

**positive control**

In genotyping experiments, a DNA sample with a known genotype, homozygous or heterozygous. In the StepOne™ software, the task for the SNP assay in wells that contain a sample with a known genotype.

**post-PCR read**

Used in genotyping and presence/absence experiments, the part of the instrument run that occurs after amplification. In genotyping experiments, fluorescence data collected during the post-PCR read are displayed in the allelic discrimination plot and used to make allele calls. In presence/absence experiments, fluorescence data collected during the post-PCR read are displayed in the presence/absence plot and used to make detection calls. Also called endpoint read.

**pre-PCR read**

Used in genotyping and presence/absence experiments, the part of the instrument run that occurs before amplification. The pre-PCR read is optional but recommended. Fluorescence data collected during the pre-PCR read can be used to normalize fluorescence data collected during the post-PCR read.

**primer mix**

PCR reaction component that contains the forward primer and reverse primer designed to amplify the target.
**primer/probe mix**
PCR reaction component that contains the primers designed to amplify the target and a TaqMan® probe designed to detect amplification of the target.

**pure dye**
See custom dye and system dye.

**quantitation method**
In quantitation experiments, the method used to determine the quantity of target in the samples. In StepOne™ and StepOnePlus™ systems, there are three types of quantitation methods: standard curve, relative standard curve, and comparative C_T (ΔΔC_T).

**quantity**
In quantitation experiments, the amount of target in the samples. Absolute quantity can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-difference between normalized quantity of target in the sample and normalized quantity of target in the reference sample.

**quencher**
A molecule attached to the 3' end of TaqMan® probes to prevent the reporter from emitting fluorescence signal while the probe is intact. With TaqMan® reagents, a nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher. With SYBR® Green reagents, no quencher is used.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

**QuickStart**
A feature in StepOne™ and StepOnePlus™ systems that allows you to run an experiment without entering plate setup information. QuickStart requires a colocated layout with the instrument powered on and an intact instrument-computer connection.

**R² value**
Regression coefficient calculated from the regression line in the standard curve. The R² value indicates the closeness of fit between the standard curve regression line and the individual C_T data points from the standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points.

**ramp**
The rate at which the temperature changes during the instrument run. Except for the melt curve step, the ramp is defined as a percentage. For the melt curve step, the ramp is defined as a temperature increment. In the graphical view of the thermal profile, the ramp is indicated by a diagonal line.

**ramp speed**
Speed at which the temperature ramp occurs during the instrument run. Available ramp speeds include fast and standard.

- For optimal results using the fast ramp speed, Applied Biosystems recommends using TaqMan® Fast reagents in your PCR reactions.
- For optimal results using the standard ramp speed, Applied Biosystems recommends using standard reagents in your PCR reactions.

**IMPORTANT!** TaqMan Fast reagents are not supported for genotyping or presence/absence experiments.

**raw data plot**
A plot of raw fluorescence signal (not normalized) for each optical filter.
reaction mix
A solution that contains all components to run the PCR reaction, except for the template (sample, standard, or control).

reagents
The PCR reaction components you are using to amplify the target and to detect amplification. Types of reagents used on the StepOne™ and StepOnePlus™ systems:
- TaqMan® reagents
- SYBR® Green reagents
- Other reagents

real-time PCR
Process of collecting fluorescence data during PCR. Data from the real-time PCR are used to calculate results for quantitation experiments or to troubleshoot results for genotyping or presence/absence experiments.

reference sample
In relative standard curve and comparative C_T (ΔΔC_T) experiments, the sample used as the basis for relative quantitation results. Also called the calibrator.

refSNP ID
Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the Applied Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called an rs number.

regression coefficients
Values calculated from the regression line in standard curves, including the R^2 value, slope, and y-intercept. You can use the regression coefficients to evaluate the quality of results from the standards. See also standard curve.

regression line
In standard curve and relative standard curve experiments, the best-fit line from the standard curve. Regression line formula:

\[ C_T = m \log (\text{Qty}) + b \]

where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

reject well
An action that the software performs during analysis to remove one or more wells from further analysis if a specific flag is applied to the well. Rejected wells contain results calculated up to the point of rejection.

relative standard curve method
Method for determining relative target quantity in samples. With the relative standard curve method, the StepOne™ software measures amplification of the target and of the endogenous control in samples, in a reference sample, and in a standard dilution series. Measurements are normalized using the endogenous control. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates target quantity in the samples and in the reference sample. The software determines the relative quantity of target in each sample by comparing target quantity in each sample to target quantity in the reference sample.

Remote Monitor
A feature in the StepOne™ software that allows you to monitor a StepOne™ or StepOnePlus™ instrument over the network. With the Remote Monitor, you can monitor the instrument status, send an experiment to the instrument, monitor amplification plots and temperature plots in real time, and download the results to your computer. You cannot operate the StepOne or StepOnePlus instrument using the Remote Monitor.
<table>
<thead>
<tr>
<th><strong>replicate group</strong></th>
<th>A set of identical reactions in an experiment.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>replicates</strong></td>
<td>Total number of identical reactions containing identical components and identical volumes.</td>
</tr>
<tr>
<td><strong>reporter</strong></td>
<td>Fluorescent dye used to detect amplification. If you are using TaqMan® reagents, the reporter dye is attached to the 5’ end. If you are using SYBR® Green reagents, the reporter dye is SYBR® Green dye.</td>
</tr>
<tr>
<td><strong>reverse primer</strong></td>
<td>An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and the forward primer are used together in PCR reactions to amplify the target.</td>
</tr>
<tr>
<td><strong>reverse transcriptase</strong></td>
<td>An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR reaction to perform 1-step RT-PCR.</td>
</tr>
<tr>
<td><strong>Rn</strong></td>
<td>See normalized reporter (Rn).</td>
</tr>
<tr>
<td><strong>ROX™ dye</strong></td>
<td>A dye supplied by Applied Biosystems and precalibrated on the StepOne™ and StepOnePlus™ systems. ROX dye is used as the passive reference.</td>
</tr>
<tr>
<td><strong>rs number</strong></td>
<td>See refSNP ID.</td>
</tr>
<tr>
<td><strong>run method</strong></td>
<td>Definition of the reaction volume and the thermal profile for the StepOne™ or StepOnePlus™ instrument run.</td>
</tr>
<tr>
<td><strong>sample</strong></td>
<td>The template that you are testing.</td>
</tr>
<tr>
<td><strong>Sample DNA (10X)</strong></td>
<td>In the StepOne™ software, a reaction component displayed on the Reaction Mix Calculations tab of the Reaction Setup screen. The software assumes the sample DNA is added to the reaction mix at a 10X concentration. For example, if the reaction volume is 20 μL, the calculated volume of sample for 1 reaction is 2 μL.</td>
</tr>
<tr>
<td><strong>Sample Library</strong></td>
<td>In the StepOne™ software, a collection of samples. The Sample Library contains the sample name and the sample color.</td>
</tr>
<tr>
<td><strong>Sample or Standard (10X)</strong></td>
<td>In the StepOne™ software, a reaction component displayed on the Reaction Mix Calculations tab of the Reaction Setup screen. The software assumes the sample or standard is added to the reaction mix at a 10X concentration. For example, if the reaction volume is 20 μL, the calculated volume of sample or standard for 1 reaction is 2 μL.</td>
</tr>
<tr>
<td><strong>sample/SNP assay reaction</strong></td>
<td>In genotyping experiments, the combination of which sample to test and which SNP assay to perform in one PCR reaction. Each PCR reaction can contain only one sample and one SNP assay.</td>
</tr>
<tr>
<td><strong>sample/target reaction</strong></td>
<td>In quantitation experiments, the combination of which sample to test and which target to detect and quantify in one PCR reaction. In the Design Wizard, you can detect and quantify only one target in one PCR reaction. Use Advanced Setup to detect and quantify more than one target in one PCR reaction.</td>
</tr>
</tbody>
</table>
serial factor
In the StepOne™ software, a numerical value that defines the sequence of quantities in the standard curve. The serial factor and the starting quantity are used to calculate the standard quantity for each point in the standard curve. For example, if the standard curve is defined with a serial factor of 1:10 or 10×, the difference between any 2 adjacent points in the curve is 10-fold.

series
See standard dilution series.

slope
Regression coefficient calculated from the regression line in the standard curve. The slope indicates the PCR amplification efficiency for the assay. A slope of −3.32 indicates 100% amplification efficiency. See also amplification efficiency (EFF%) and regression line.

SNP
Abbreviation for single nucleotide polymorphism. The SNP can consist of a base difference or an insertion or deletion of one base.

SNP assay
Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP and two probes to detect different alleles.

SNP Assay Library
In the StepOne™ software, a collection of SNP assays to add to genotyping experiments. The SNP assays in the library contain the SNP assay name, SNP assay color, and for each allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP assays in the library may also contain the assay ID and comments about the SNP assay.

spatial calibration
Type of StepOne™ and StepOnePlus™ system calibration in which the system maps the positions of the wells in the sample block(s). Spatial calibration data are used so that the software can associate increases in fluorescence during a run with specific wells in the reaction plate.

stage
In the thermal profile, a group of one or more steps. There are three types of stages: holding stage (including pre-PCR read and post-PCR read), cycling stage (also called amplification stage), and melt curve stage.

standalone layout
A system layout in which the StepOne™ or StepOnePlus™ instrument is not connected to a computer by the yellow cable. In this layout, you control the instrument only with the instrument touchscreen, and you use a USB drive or network connection to transfer data between the instrument and computer.

standard
Sample that contains known standard quantities. Standard reactions are used in quantitation experiments to generate standard curves. See also standard curve and standard dilution series.

standard curve
In standard curve and relative standard curve experiments:
- The best-fit line in a plot of the Cₜ values from the standard reactions plotted against standard quantities. See also regression line.
- A set of standards containing a range of known quantities. Results from the standard curve reactions are used to generate the standard curve. The standard curve is defined by the number of points in the dilution series, the number of standard replicates, the starting quantity, and the serial factor. See also standard dilution series.
**standard curve method**  
Method for determining absolute target quantity in samples. With the standard curve method, the StepOne™ software measures amplification of the target in samples and in a standard dilution series. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates the absolute quantity of target in the samples. See also standard and standard curve.

**standard dilution series**  
In standard curve and relative standard curve experiments, a set of standards containing a range of known quantities. The standard dilution series is prepared by serially diluting standards. For example, the standard stock is used to prepare the first dilution point, the first dilution point is used to prepare the second dilution point, and so on. In the StepOne™ software, the volumes needed to prepare a standard dilution series are calculated by the number of dilution points, the number of standard replicates, the starting quantity, the serial factor, and the standard concentration in the stock. See also standard curve.

**standard quantity**  
A known quantity in the PCR reaction.

- In standard curve experiments, the quantity of target in the standard. In the StepOne™ software, the units for standard quantity can be for mass, copy number, viral load, or other units for measuring the quantity of target.
- In relative standard curve experiments, a known quantity in the standard. Standard quantity can refer to the quantity of cDNA or the quantity of standard stock in the PCR reaction. The units are not relevant for relative standard curve experiments because they cancel out in the calculations.

**starting quantity**  
When defining a standard curve in the StepOne™ software, corresponds to the highest or lowest quantity.

**step**  
A component of the thermal profile. For each step in the thermal profile, you can set the ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration), and you can turn data collection on or off for the ramp or the hold parts of the step. For cycling stages, a step is also defined by the AutoDelta status. With StepOnePlus™ systems, which contain the VeriFlex™ blocks, each step contains 6 temperatures (1 for each VeriFlex block).

**SYBR® Green reagents**  
PCR reaction components that consist of two primers designed to amplify the target and SYBR® Green dye to detect double-stranded DNA.
**system dye**  
Dye supplied by Applied Biosystems and precalibrated on the StepOne™ or StepOnePlus™ system. Before you use system dyes in your experiments, make sure the system dye calibration is current in the Instrument Maintenance Manager.

System dyes on the StepOne system:
- FAM™ dye
- JOE™ dye
- ROX™ dye
- SYBR® Green dye
- VIC® dye

System dyes on the StepOnePlus system:
- FAM™ dye
- JOE™ dye
- NED™ dye
- ROX™ dye
- SYBR® Green dye
- TAMRA™ dye
- VIC® dye

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

**TaqMan® reagents**  
PCR reaction components that consist of primers designed to amplify the target and a TaqMan® probe designed to detect amplification of the target.

**target**  
The nucleic acid sequence that you want to amplify and detect.

**target color**  
In the StepOne™ software, a color assigned to a target to identify the target in the plate layout and analysis plots.

**Target Library**  
In the StepOne™ software, a collection of targets to add to experiments. The targets in the library contain the target name, reporter, quencher, and target color. The target in the library may also contain comments about the target.

**task**  
In the StepOne™ software, the type of reaction performed in the well for the target or SNP assay. Available tasks:
- Unknown
- Negative Control
- Standard (standard curve and relative standard curve experiments)
- Positive control (genotyping experiments)
- IPC (presence/absence experiments)
- Blocked IPC (presence/absence experiments)
**temperature plot**  
In the StepOne™ software, a display of temperatures for the sample, instrument cover, and instrument block during the StepOne™ or StepOnePlus™ instrument run.

**template**  
In the Design Wizard of the StepOne™ software (and in QuickStart for quantitation experiments), the type of nucleic acid to add to the PCR reaction. The recommended template varies according to experiment type:

- **Quantitation experiments** (standard curve, relative standard curve, and comparative C<sub>T</sub>) – cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)  
  For quantitation experiments, the template type selection affects the run method, reaction setup, and materials list.
- **Genotyping experiments** – Wet DNA (gDNA or cDNA) or dry DNA (gDNA or cDNA)  
  For genotyping experiments, the template type selection affects the reaction setup.
- **Presence/absence experiments** - DNA  
  For presence/absence experiments, Applied Biosystems recommends adding DNA templates to the PCR reactions.

**thermal profile**  
Part of the run method that specifies the temperature, time, ramp, and data collection points for all steps and stages of the StepOne™ or StepOnePlus™ instrument run.

**threshold**  
1. In amplification plots, the level of fluorescence above the baseline and within the exponential growth region. The threshold can be determined automatically (see automatic C<sub>T</sub>) or can be set manually (see manual C<sub>T</sub>).

2. In presence/absence experiments, the level of fluorescence above which the StepOne™ software assigns a presence call.

**threshold cycle (C<sub>T</sub>)**  
The PCR cycle number at which the fluorescence meets the threshold in the amplification plot.

**Tm**  
See melting temperature (Tm).

**touchscreen**  
Instrument display that you touch to control the StepOne™ or StepOnePlus™ instrument.

**unknown**  
In the StepOne™ software, the task for the target or SNP assay in wells that contain the sample you are testing:

- In quantitation experiments, the task for the target in wells that contain a sample with unknown target quantities.
- In genotyping experiments, the task for the SNP assay in wells that contain a sample with an unknown genotype.
- In presence/absence experiments, the task for the target in wells that contain a sample in which the presence of the target is not known.

**unknown-IPC wells**  
In presence/absence experiments, wells that contain a sample and internal positive control (IPC).
VeriFlex™ Technology

The StepOnePlus™ instrument contains six independently thermally regulated VeriFlex™ blocks, creating up to six different zones for the 96 sample wells. After you enable the VeriFlex blocks in the StepOne™ software, you can set a different temperature for one or more of the VeriFlex blocks.

y-intercept

In the standard curve, the value of y where the regression line crosses the y-axis. The y-intercept indicates the expected threshold cycle (C_T) for a sample with quantity equal to 1.

zone

One of up to six sample temperatures among the 96 wells formed by independently thermally regulated VeriFlex™ blocks during the StepOnePlus™ instrument run. You can set a different temperature for one or more of the VeriFlex blocks, or you can set the same temperature for each of the VeriFlex blocks.

Note: For melt curve steps, you need to set the same temperature for each of the VeriFlex blocks.

zone boundary

The edge of a zone for samples formed by the six independently thermally regulated VeriFlex™ blocks. In the StepOne™ software, the zone boundaries are displayed in the plate layout as thick red lines.
A

Advanced Setup 7, 10, 110
alternate experiment workflows. See workflows.
amplification curve 89
amplification plot
viewing 87
Amplification Plot screen
monitor during a run 64
AMPNC 101
analysis settings
baseline 99
call settings 99
flag settings 99
threshold 99
viewing 98
Applied Biosystems
contacting xii
customer feedback on documentation xii
Technical Support xii
Applied Biosystems StepOne Real-Time PCR System.
See StepOne system.
assumptions for using this guide viii

B

BADROX 101
baseline
correct values 90
examples 92
biohazardous waste, handling xx
BLFAIL 101
blocked IPC 94

C

CAUTION, description xiii
chemical safety xviii
chemical waste safety xix
colocated layout
data transfer 71
monitoring 63
startup 59
consumables 43
Also see materials required 4
supported 4
conventions used in this guide viii
create an experiment
example experiment 17

CT Settings 99
CTFAIL 101
curves, amplification 89
customer feedback, on Applied Biosystems
documents xii
data
about data collection 2
transfer 70
design experiment
define experiment properties 20
define methods and materials 23
design wizard
finish design wizard 38
devation, standard 91
documentation, related ix
duplex PCR 10

E

electrical safety xx
electromagnetic compatibility standards. See EMC
standards
EMC standards xxii
ergonomics, safety xxii
example experiment
analyze 78
data location 12
description 9, 10, 26
name 20
plate layout 11
run 54
sample dilutions 46
template 10
workflow 12, 16
EXPFAIL 101
Export/Import 10, 115

F

FAM dye 103
flags 99, 101

G

General xxi
Index

H
hazard icons. See safety symbols, on instruments
hazard symbols. See safety symbols, on instruments
hazards. See safety
Help system, accessing xi

I
installation category xxi
instrument operation, safety xvii
inventoried/made to order 31
IPC
calls 86
DNA 31
failed 94
mix 31
succeeded 94
threshold 85

L
library 29
load reaction plate 56

M
Methods and Materials screen 23
monitor run
   Amplification Plot screen 64
colocated layout 63
Run Method screen 66
standalone layout 69
standalone layout (remote) 67
Temperature Plot screen 65
moving and lifting, safety xvii
MSDSs
description xviii
obtaining xviii
MSDSs, obtaining xii
multicomponent plot 103
multiple plots, viewing 83

N
negative control 86, 94, 104
negative control - blocked IPC 27
negative control - IPC 27
NOAMP 101
NOISE 101
NOSIGNAL 101
notification settings 57

O
OFFSCALE 101
omit wells 102
online Help. See Help system
other fluorescent-based reagents 7
overvoltage category (rating) xxi

P
plate layout 11
prepare for run 55
presence/absence
   about 6
   flags 101
   materials 35
   plot 84
 QC Summary 100
QuickStart 10, 111

R
radioactive waste, handling xx
reaction mix
   prepare 31, 46
reaction plate
   layout 11
   load 56
   unload from the instrument 70
Reaction Setup screen 31
reaction volume 29
reagents
   other fluorescent-based 7
   supported 7
   TaqMan 7
repetitive motion, safety xxii
ROX dye 103
run experiment
   alerts 66
   enable notification settings 57
   for more information 57, 66, 67
guidelines 58
   monitor 63
   prepare for 55
   start 59
   transfer data 70
   workflow 54
Run Method library 29
Run Method screen 29
   monitor during a run 66
   run method view 29
Index

S
safety
  before operating the instrument xvii
  biological hazards xxi
  chemical xviii
  chemical waste xix
  conventions xiii
  electrical xx
  ergonomic xxii
  guidelines xviii, xix, xx
  instrument operation xvii
  moving and lifting instrument xvii
  moving/lifting xvii
  repetitive motion xxii
  standards xxii
  workstation xxii
safety labels, on instruments xvi
safety standards xxii
safety symbols, on instruments xv
sample dilutions 46
Samples and Replicates screen 26
selecting wells 38
software elements, design wizard 18
SPIKE 101
standalone layout
data transfer 72
monitoring 69
remote data transfer 71
Remote Monitor 67
startup 60
standard deviation, effect of threshold on 91
standards
  EMC xxii
  safety xxii
start run
colocated layout 59
standalone layout 60
StepOne system
  about 2
  consumables 2, 4
  data collection 2
  filters 3, 106
  layouts 59, 63, 70
SYBR Green reagents 3, 106
symbols, safety xv

T
TaqMan reagents 3, 7, 23, 24, 106
target
calls 86
name 43
threshold 85
Targets screen 25
Technical Support, contacting xii
Temperature Plot screen 65
Template 10, 113
template 43
text conventions viii
THOLDFAIL 101
threshold
correct values 90
examples 91
threshold, adjusting 99
training, information on xii
transfer data 70
troubleshooting
  adjust baseline 99
  adjust threshold 99
  flags 99, 101
  omit wells 102
  view multicomponent plot 103
  view QC summary 100
  view raw data plot 105
U
unconfirmed call 85, 94
unknown - IPC 26
unload instrument 70
user attention words, described viii
using this guide
  as a tutorial 9
  with your own experiments 10
V
VIC dye 103

W
WARNING, description xiii
waste disposal, guidelines xx
waste profiles, description xx
Well Table, viewing 93
wells
  negative control 27, 104
  omitting 102
  selecting 38, 82
  unknown 26
workflows
  Advanced Setup 110
  example experiment 12
  Export/Import 10, 115
  QuickStart 10, 111
  Template 10, 113
  tutorial 9
workstation safety xxii
Worldwide Sales and Support

Applied Biosystems vast distribution and service network, composed of highly trained support and applications personnel, reaches 150 countries on six continents. For sales office locations and technical support, please call our local office or refer to our Web site at www.appliedbiosystems.com.

Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (in North America): +1 800.345.5224
Fax: +1 650.638.5884

12/2008